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ÉÉDDIITTOORRIIAALL

BIENVENUE DANS UN NOUVEAU NUMÉRO DU FULL CIRCLE

G reg et Elmer reviennent tous deux ce mois (pour Python et LibreOffice respectivement), de
même que John, qui revient avec un nouvel article sur LaTex. Le quatrième article n'est pas

vraiment un tutoriel, mais j'ai voulu l'inclure pour que nos lecteurs programmeurs puissent se faire
plaisir tout au long de décembre. C'est un article de programmation de l'avent. En d'autres termes,
un défi quotidien du premier au 24 décembre (veille de Noël).

Ce mois-ci, Charles aborde les imprimantes 3D. C'est quelque chose dont j'envisage de parler à
partir du mois prochain, car je viens juste de recevoir une RepRap Pro Fisher 1 . Cette imprimante
était jusque-là vendue comme prototype en version bêta, mais elle est maintenant passée en
version 1 .0 ; j'aborderai la construction et le logiciel dans les mois à venir.

Au moment où j'écris ces lignes, la dernière mise à jour pour Ubuntu Phones (OTA-8) vient de
sortir. Ce sera la dernière mise à jour de 201 5. La sortie de la prochaine, OTA-9, est prévue pour fin
janvier 201 6. Et nos lecteurs russes seront heureux d'apprendre que le BQ ES est désormais
disponible à la vente en Russie et dispose de scopes russes spécifiques pré-installés. Amusez-vous
bien !

Je dispose aussi de quelques livres sur lesquels je dois sérieusement me pencher avant d'en
écrire une critique. L'un s'intitule HowSoftwareWorks (Comment fonctionne un logiciel) et l'autre,
The Maker's Guide to the Zombie Apocalypse (Le guide du créateur de l'apocalypse des zombies).
Oh… et j'aurai encore une critique littéraire le mois prochain.

Amitiés et à bientôt !
Ronnie

ronnie@fullcirclemagazine.org
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AACCTTUUSS

MARKSHUTTELWORTH

ANNONCE QUE SNAPPYUBUNTU

16.04 LTS SUPPORTERA

LES DRIVERSNVIDIA ETAMD

Vous souvenez-vous les gars quand
on vous a dit que Mark Shuttle-

worth - celui qui a créé Canonical et
Ubuntu Linux, l'OS libre le plus popu-
laire au monde - déclarait que Snappy
Unbuntu Core 1 6.04 LTS supporterait
des snaps privés ?

Bon, on a aujourd'hui encore plus
de super nouvelles pour tous ceux d'en-
tre vous qui utilisent l'OS Snappy
Ubuntu Core sur des appareils intégrés
ou connectés. M. Shuttlewoth a an-
noncé dans un récent courriel adressé
à la liste de distribution de Snappy Core
que le prochain OS Ubuntu Snappy
Core 1 6.04 LTS (Xenial Xenus) suppor-
terait les drivers graphiques proprié-
taires.

Quand Dan Kegel demanda si le
Snappy Ubuntu Core supporterait les
drivers graphiques OpenGL à hautes
performances tels que ceux, proprié-
taires, de Nvidia et AMD ou ceux d'Intel,
Mark Shuttleworth répondit immédia-

tement qu'ils seraient tous supportés
dans la version 1 6.04 LTS de l'OS.

Source :
http://linux.softpedia.com/blog/snap
py-ubuntu-1 6-04-lts-will-support-
nvidia-and-amd-drivers-says-mark-
shuttleworth-495462.shtml

IBM RENVOIE SESGROS

SYSTÈMESLINUXVERS LE FUTUR

I BM a ajouté un nombre important de
nouveaux éléments dans son offre

de serveurs Linux le mois dernier : sup-
port de KVM (Ndt : Kernel based Vir-
tual Machine) sur ses unités centrales
z Systems, machines exclusivement
Linux à la fois dans la gamme z Sys-
tems et Power System et un nouveau
modèle d'achat.

La nouveauté la plus attrayante
techniquement est l'introduction de
KVM sur les unités centrales, l'hyper-
viseur natif du noyau Linux. Bien que
ce ne soit qu'une autre façon d'ob-
tenir des services que les produits IBM
offraient déjà, cela pourrait aider la
migration de travaux exécutés actuel-
lement sur des x86 vers des appareils

de hauts niveaux d'IBM.

Les gros systèmes de Big Blue
[Ndt : IBM] offrent déjà de belles pos-
sibilités de virtualisation. Au niveau le
plus bas, le système PR/SM [Ndt : Pro-
cessor Resource/System Manager, hy-
perviseur contrôlant les machines vir-
tuelles] découpe les ressources de la
machine en un grand nombre de par-
titions logiques LPAR [Ndt : Logical
PARtition], chacune apparaissant comme
une machine séparée qui partage la
puissance de calcul et les capacités de
stockage de l'hôte. Même si la ma-
chine est configurée comme une unité
séparée, elle est en réalité une LPAR.

Source :
http://www.theregister.co.uk/201 5/1
1 /02/ibm_linux_mainframes/

COMMENT VA SE JOUER LA

MODE DU BIGDATA ?

Q ue s'est-il passé en 201 1 ? Est-ce que
le Big Data est apparu spontané-

ment ? Ou y a-t-il eu un type quelconque
de campagne de publicité ? Ou diverses
campagnes coordonnées ?

Bien que je ne puisse pas le prou-
ver (ou n'aie pas le temps de le faire)
je pense que la cause principale était
« Big Data : la nouvelle frontière de
l'innovation, de la compétition et de
la productivité » publié à grand bruit
par McKinsey en mai 201 1 . Ce rapport
et les suivant de McKinsey, ont in-
fluencé la publicité dans Forbes, The
Economist, dans différentes publicités
des éditions O'Reilly, du FinancialTimes
et beaucoup d'autres, tout en géné-
rant de bons volumes de vente aux
fournisseurs qui vendent des produits
et des services relatifs au Big Data.

De tous ces fournisseurs aucun n'a
mieux utilisé ce mouvement ni créé plus
de rumeurs qu'IBM. Il n'y a qu'à regarder
les résultats des publications sur Google
concernant la recherche IBM + « Big
Data » pour les années calendaires 2010-
201 1 . Notez que la première publication
« Apporter le Big Data dans l'entre-
prise » est datée du 16 mai 201 1 , le mois
même du rapport McKinsey. La suivante
« IBM Big Data - par où commencer ? »
date du 23 novembre 201 1 .

Source :
http://www.linuxjournal.com/content
/how-will-big-data-craze-play-out

Soumis par Arnfried Walbrecht

http://linux.softpedia.com/blog/snappy-ubuntu-16-04-lts-will-support-nvidia-and-amd-drivers-says-mark-shuttleworth-495462.shtml
http://www.theregister.co.uk/2015/11/02/ibm_linux_mainframes/
http://www.linuxjournal.com/content/how-will-big-data-craze-play-out
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ACTUS
MICROSOFT ETREDHAT
PARVIENNENT À UN ACCORD

SURLINUX

M icrosoft Corp. et Red Hat inc.,
longtemps rivaux et en conflit

dans le domaine de l'industrie logi-
cielle, envisagent de collaborer dans
le nuage.

Les sociétés ont annoncé un par-
tenariat vendredi portant sur une ver-
sion Red Hat de l'OS Linux qui serait
mise à disposition des utilisateurs de
Microsoft Azure, le service logiciel en
nuage de l'entreprise.

Selon l'accord, Microsoft a accepté
de nommer Linux Red Hat comme
son option « préférée » pour les tra-
vaux informatiques à destination des
entreprises sur son réseau Azure. De
plus, des personnels des deux entre-
prises vont travailler ensemble à Red-
mond Wash. - le siège de Microsoft –
pour offrir un support technique aux
clients.

Aucun élément financier de l'ac-
cord n'a été dévoilé.

Source :
http://www.wsj.com/articles/microso
ft-and-red-hat-reach-linux-deal-
1 446642000

OMNIRAT PERMET

AUXHACKERS DE PRENDRE

LE CONTRÔLE DES TÉLÉPHONES

ANDROID ET DES ORDINATEURS

WINDOWS, MAC ETLINUX

RAT signifie Remote Acces Trojan
[(Ndt : Cheval de Troie « télégui-

dable »] (certains disent également
Tool (outil)) et désigne un maliciel par-
ticulier qui infecte l'ordinateur par le
biais d'un composant d'un fournisseur
et commence à communiquer avec un
serveur dédié. Cela permet à l'atta-
quant de récupérer des données de la
cible, d'espionner l'utilisateur et même
de prendre le contrôle de l'appareil
de la victime.

Contrairement à d'autres RAT sur
Android, OmniRAT peut aussi prendre
le contrôle d'ordinateurs de bureau,
une chose que ses concurrents ne sa-
vaient pas faire.

De plus, OmniRAT coûte dix fois
moins cher que ses concurrents et est
vendu à des prix variant de 25 à 50 $
(23 à 46 €).

Un tel logiciel n'est pas illégal prin-
cipalement parce qu'il est utilisé quo-
tidiennement par des programmeurs
et des testeurs. RAT ne devient illégal
qu'en servant à des fins de piratage.

C'est dernièrement, vers la mi-
août, qu'Avast a détecté une cam-
pagne de piratage qui utilisait une
version d'OmniRAT et se diffusait via
des messages SMS.

Source :
http://news.softpedia.com/news/om
nirat-lets-hackers-control-android-
phones-windows-mac-and-linux-pcs-
495779.shtml

LE KERNEL DE LADISPUTE

L inux, l'OS que Torvalds a créé et
auquel il a donné son nom, est en

train de dominer le marché en ligne,
en pleine expansion, et gagne en
popularité sur ses rivaux Microsoft et
Apple.

Mais, alors que Linux est rapide,
flexible et libre, un chœur de critiques
grandissant dénonce des failles de
sécurité qui pourraient être réparées,
mais qui ne le sont pas. Pire, alors que
la sécurité sur Internet devient un
problème international, Torvalds s'est
engagé dans un conflit parfois violent
avec des experts sur le sujet. Il a écarté
un groupe qui attaquait les éléments
de sécurité produits par un autre groupe,
les traitant de « singes qui se mas-

turbent », leur disant dans un mes-

sage public : « tuez-vous tout de suite,

lemondeneserajamaismeilleur».

Source :
http://www.washingtonpost.com/sf/
business/201 5/1 1 /05/net-of-
insecurity-the-kernel-of-the-
argument/

MENTORGRAPHICS ANNONCE
UN IOT PERSONNALISABLE, SÛR
DE L'ÉMETTEUR AU RÉCEPTEUR,
COMPORTANT UNE PASSERELLE,
DES ÉLÉMENTS DÉDIÉS AU NUAGE

ET À LA TÉLÉPHONIE MOBILE

M entor Graphics Corporation a
annoncé la disponibilité de sa

solution personnalisable de téléphonie
mobile vers le nuage pour IoT [Ndt :
Internet of Things : objets connectés]
qui permet aux entreprises de mettre
leurs produits sur le marché plus rapi-
dement, tout en les aidant à réduire
les risques, les coûts et les cycles de
développement. La solution Mentor
pour objets connectés comprend une
plateforme spécialisée unique System
Design Kit (Sys DK), une interface vers
le nuage et une solution exécutable
(runtime) sur laquelle on peut bâtir
une communication avec la téléphonie
mobile. Elle satisfait aux nécessités

http://www.wsj.com/articles/microsoft-and-red-hat-reach-linux-deal-1446642000
http://news.softpedia.com/news/omnirat-lets-hackers-control-android-phones-windows-mac-and-linux-pcs-495779.shtml
http://www.washingtonpost.com/sf/business/2015/11/05/net-of-insecurity-the-kernel-of-the-argument/
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ACTUS
des objets connectés et peut tourner
sur des contrôleurs 8 bits aussi bien
que sur des microprocesseurs 64 bits,
avec des contrôleurs de 1 00 000 con-
nexions et plus, chacune supportant
des douzaines d'appareils utilisant le
réseau de téléphonie mobile.

Pour offrir aux clients la flexibilité
et satisfaire aux besoins commerciaux,
les licences peuvent couvrir la totalité
du projet ou compléter une offre déjà
existante du client. De plus, Mentor
Graphics peut déployer et gérer la
solution comme un service client. Les
deux options sont disponibles aujour-
d'hui.

Source :
http://www.arcweb.com/Blog/Post/8
59/Mentor-Graphics-Announces-
Customizable,-Secure-End-to-End-
IoT-Solution-with-Integrated-
Gateway,-Cloud-and-Edge-Devices

LES DERNIÈRES FUITES SUR LA
TPP RÉVÈLENT DES RISQUES

SYSTÉMIQUES SUR LA LIBERTÉ

DES LOGICIELS

Le 25 mars, 201 5 Wikileaks a révélé
un chapitre qui avait fuité des

négociations de partenariat trans-
Pacifique TPP [Ndt : Trans-Pacific Part-

nership], un accord multinational sur
le commerce qui se négocie au cours
de réunions secrètes et qui tend à
créer un ensemble de nouvelles res-
trictions. Nous avons à la FSF [Ndt :
Free Software foundation, fondation
pour le Logiciel libre] lutté pendant des
années contre la TPP car elle repré-
sente le risque d'un monde dominé
par les DRM, les brevets logiciels et
les copyrights perpétuels.

Le dernier chapitre sur les inves-
tissements qui a été dévoilé montre
une évolution vers des cours supra-
nationales dénommées Règlements des
conflits extra-judiciaires entre inves-
tisseurs et États (ISDS). Depuis des
années ces cours ont permis à de
grosses sociétés de poursuivre des
gouvernements élus démocratique-
ment sur des règlements que ces
sociétés leur opposent. Par exemple,
Big Tobbaco a utilisé le système pour
bloquer ou ou s'opposer à des lois sur
la santé dont l'objectif était de ré-
duire la consommation de tabac dans
le monde.

Alors que tout est mauvais dans le
document, un point particulier repré-
sente un risque certain pour la liberté
des logiciels. Les tenants de copyright,
de brevets ou de droits de propriétés
sont maintenant inclus dans la notion
d'« investisseur ». Étant donné la nature

destructive de ces conventions, le fait
que des développeurs propriétaires
puissent les utiliser pour aller à l'encon-
tre de la protection des droits des utili-
sateurs assurée par les gouvernements
locaux est une réelle cause d'alarme.

Source :
https://www.fsf.org/blogs/licensing/l
atest-tpp-leak-shows-systemic-threat-
to-software-freedom

UN NOUVEAU CRYPTAGE, DÛ À
DES MALICIELS QUI DEMANDENT

DES RANÇONS, S'ATTAQUE
ÀDES SYSTÈMES LINUX

L 'éditeur de logiciels antivirus, Doc-
tor Web a publié une alerte con-

cernant des maliciels de cryptage qui
s'attaquent à des utilisateurs d'OS
basés sur Linux. Intitulé « Linux.En-
coder.1 » par l'entreprise, le maliciel
s'attaque à des serveurs Web en cryp-
tant leur contenu et en demandant une
rançon d'un Bitcoin (environ 500 $).

Pour la plupart des systèmes in-
fectés, les pirates ont utilisé une faille
du CMS Magento. La correction d'une
faille critique du logiciel Magento, qui
est utilisé pour programmer un grand
nombre de sites de e-commerce, a été
publiée le 31 octobre. Les chercheurs

de Doctor Web ont indiqué que le
nombre de victimes était de l'ordre
«  de la dizaine au moins », mais les
attaques sur d'autres logiciels de ges-
tion de contenu vulnérables pourraient
sérieusement augmenter le nombre
de victimes.

Pour pouvoir fonctionner, le ma-
liciel doit être exécuté avec les droits
administrateur. En utilisant un cryp-
tage AES 1 28 bits, le maliciel encrypte
le contenu du répertoire home de
tous les utilisateurs et tous les fichiers
associés aux sites Internet tournant
sur le système. Il parcourt ensuite toute
la structure des répertoires des vo-
lumes montés encryptant une grande
variété de types de fichiers. Dans cha-
que répertoire qu'il encrypte, il
dépose un fichier texte nommé
README_FOR_DECRYPT.txt. Il s'agit
d'une demande de paiement qui four-
nit un lien Tor vers un site de « service
caché » via une passerelle Tor.
Source :
http://arstechnica.com/security/201 5
/1 1 /new-encryption-ransomware-
targets-linux-systems/

http://www.arcweb.com/Blog/Post/859/Mentor-Graphics-Announces-Customizable,-Secure-End-to-End-IoT-Solution-with-Integrated-Gateway,-Cloud-and-Edge-Devices
https://www.fsf.org/blogs/licensing/latest-tpp-leak-shows-systemic-threat-to-software-freedom
http://arstechnica.com/security/2015/11/new-encryption-ransomware-targets-linux-systems/
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ACTUS
LALINUXFOUNDATION LANCE

UN GROUPEOPEN SOURCE DE

CALCUL HAUTES PERFORMANCES

L a Linux Foundation, une organi-
sation à but non lucratif qui pro-

meut le noyau Linux et d'autres pro-
jets Open Source, s'est associée avec
Dell, HP Enterprise, Intel, Fujitsu Sys-
tems Europe et un grand nombre de
laboratoires de recherche d'universités
pour créer un projet HPC ouvert. La
collaboration se focalisera sur quatre
objectifs principaux :
••Promouvoir un environnement stable
de test pour des logiciels HPC.
••Créer un cadre Open Source pour
des environnements HPC afin de ré-
duire les coûts.
••Développer un ensemble de logi-
ciels HPC sophistiqués pouvant être
utilisés dans un grand nombre d'ap-
plications.
••Créer une configuration de base qui
offre aux développeurs et aux utili-
sateurs la flexibilité nécessaire pour
ajuster leurs logiciels en fonction de
leurs besoins.

C'est le bon moment pour investir
dans des logiciels Open Source HPC
car de tels logiciels sont vitaux dans
des domaines tels que la météoro-
logie, l'astronomie, l'engineering et la
physique nucléaire, et ils n'ont pas

encore été développés de façon cen-
tralisée et efficace selon la Linux
Foundation.

Source :
http://thevarguy.com/open-source-
application-software-
companies/linux-foundation-
launches-open-source-high-
performance-co

« PLUS PETIT QU'UNE CARTE DE

CRÉDIT» DE PETITS SUPER-CALCU-
LATEURS POURRAIENT AMENER À

DES DRONES AUTO-GUIDÉS

Avec le nouveau module d'appren-
tissage pour machine de Nvidia

les entreprises pourront identifier les
véhicules de fabrication, les matériaux
de construction et toute information
pertinente à la gestion de leur site de
travail en utilisant des drones com-
merciaux.

De ce fait, la plateforme est ca-
pable d'effectuer des tâches com-
plexes telles que la reconnaissance
d'images, le traitement d'une conver-
sation ou traverser une pièce pleine
de meubles après l'avoir analysée.
Nvidia a décrit les capacités d'appren-
tissage de la machine TX1 de Jetson
comme « une technologie novatrice

qui va faire faire un pas de géant dans

lacapacitédessystèmesautonomes».

Nvidia aimerait que l'on pense que
cette nouvelle Jetson TX1 est en
quelque sorte une mise à niveau de
l'intelligence artificielle des ordinateurs
et des réseaux dans le but de favo-
riser les systèmes autonomes en per-
mettant à la machine d'apprendre.

Source :
http://heraldvoice.com/201 5/1 1 /1 5/s
maller-than-a-credit-card-tiny-
supercomputer-could-mean/

LINUX4.4 JETTE UN ŒIL DANS

LE FUTUR AVEC SA PREMIÈRE

PRÉ-VERSION

L inux a déjà dépassé le point où,
théoriquement, Skynet devrait

avoir créé un terminator T-800 pour
sauver John Connor et le marion-
nettiste de Linux, Linus Torvalds a sorti
la première pré-version pour le noyau
version 4.4. « En regardant la mise à

jour, les choses semblent plutôt nor-

males à haut niveau juste un peu plus

orientées vers les drivers que d'habi-

tude avec environ 75 % de la mise à

jour concernant les drivers et 10 %

l'architecture », dit Torvalds dans un
commentaire de version.

« les 15 % restants étant de la do-

cumentation, des fichiers système, des

fichiers réseau du noyau (par opposi-

tion auxdrivers réseau) quelques outils

etdel'infrastructurenoyau. »

Il a aussi expliqué que les modi-
fications de drivers pour l'organisa-
tion, les réseaux et les drivers GPU
représentent 40 % de la mise à jour
totale du noyau.

À peu près la moitié est destinée
aux architectures ARM alors que les
x86 et autres représentent l'autre
moitié.

Le changement est, comme tou-
jours, énorme en taille, mais comprend
un bon nombre d'améliorations pour
les objets connectés, un support pour
les processeurs ARM et des mises à
jour pour les DRM. Il est fort probable
qu'il y ait une dizaine de pré-versions
avant que la version finale ne soit
publiée quelque part dans le courant
de l'année prochaine.
Source :
http://www.theinquirer.net/inquirer/
news/2434899/linux-44-glimpses-the-
future-with-its-first-release-candidate

http://thevarguy.com/open-source-application-software-companies/linux-foundation-launches-open-source-high-performance-co
http://heraldvoice.com/2015/11/15/smaller-than-a-credit-card-tiny-supercomputer-could-mean/
http://www.theinquirer.net/inquirer/news/2434899/linux-44-glimpses-the-future-with-its-first-release-candidate
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ACTUS
FREESCALE INVESTIT
SIGNIFICATIVEMENT DANSREAL
TIME LINUX

F reescale vient juste d'annoncer qu'il
rejoint le Real Time Linux (RTL)

Collaborative Project [Ndt : projet col-
laboratif de Linux temps réel] en tant
que Gold Member. Freescale rejoint
Google, National Instruments, OSADL
et TI avec un investissement signifi-
catif parce qu'ils apprécient l'importance
stratégique de ce projet Open Source
et les bénéfices que pourront en tirer
leurs clients.

L'adoption de Linux pour les ap-
plications embarquées suit une route
analogue à ce que nous avons vu dans
la téléphonie mobile où les smart-
phones et leurs applications ont con-
duit à de nouvelles expériences etmême
au succès commercial le plus impor-
tant de Linux (par le biais d'Android).
Dans le cas des systèmes embarqués,
les avancées de l'intelligence artifi-
cielle, de la reconnaissance d'image
et de voix suscitent des innovations
massives basées sur la puissance, la
flexibilité et les avantages en terme
de coûts des systèmes Linux embar-
qués. Par exemple, en ce qui concerne
les drones et les voitures, nous assis-
tons à une convergence de la recon-
naissance d'image de haut niveau et

de l'intelligence artificielle qui ouvre
la voie à des navigations sans pilote ni
chauffeur. Des robots aux drones et
aux voitures, un noyau temps réel Linux
est essentiel pour la mise en place de
ces solutions qui ne tarderont pas à
être commercialisées.

Source :
http://www.linux.com/news/featured
-blogs/204-mike-woster/867455-
freescale-joins-real-time-linux-project-
as-gold-member

NUMECENT LÈVE 15,5 MILLIONS

DE DOLLARS POUR PORTER LE

CLOUDPAGING SURANDROID
ETLINUX

L 'entreprise de logiciels Numecent
basée à Irvine en Californie, a

annoncé aujourd'hui qu'elle a levé
1 5,5 millions de dollars sur un grand
éventail de sociétés d'investissement
européennes dans le but d'étendre ses
services basés sur le nuage au-delà des
systèmes Windows.

Le deuxième tour de table com-
prend 4,5 millions de dollars de Deutsche
Telekom et le reste provenant « d'in-

dustriels européens, d'entreprises fami-

liales et de fonds d'investissement pri-

vés»selon Numecent. Deutsche Telekom

a également mené le premier tour de
table de la compagnie.

« Numecent est sur une bonne tra-

jectoire et reçoit une impulsion des ac-

teurs majeurs de l'industrie », a dit Vi-
cente Vento, président du comité de
supervision des investissements straté-
giques de Deutsche Telekom, dans un
communiqué. « Cette impulsion valide

l'idée que le cloudpaging estune évolu-

tion potentielle non seulementpourles

technologiesde l'information, mais éga-

lement pour des secteurs émergents

commelesobjetsconnectés. »

Source :
http://venturebeat.com/201 5/1 1 /1 7/
numecent-raises-1 5-5m-to-bring-
cloudpaging-to-android-and-linux/

TEXAS INSTRUMENTS –
DESKITS PERMETTENT
DES DÉVELOPPEMENTS RAPIDES

ET SIMPLES DE LOGICIELS

ET DE MATÉRIELS LINUX

L e kit de développement OMAP-
L1 38 DSP+ARM9 de Texas Instru-

ments est fait pour permettre des
développements rapides et simples
de matériels et de logiciels Linux.

La plateforme paramétrable peut
faciliter et accélérer le développement
de logiciels et de matériels pour des
applications quotidiennes qui nécessitent
un traitement du signal en temps réel
et un contrôle fonctionnel comme les
contrôles industriels, les diagnostics
médicaux et les communications.

Le kit, bon marché, avec des des-
sins de circuits et des schémas libre-
ment téléchargeables, réduit grande-
ment le travail de conception. Une
grande variété d'interfaces standards
pour la connectivité et le stockage
permet aux développeurs d'amener
facilement des signaux audio, vidéo
ou autres sur le circuit. Des exten-
sions telles que des écrans LCD ou
des caméras optiques Leopard per-
mettent aux utilisateurs d'étendre les
fonctionnalités des circuits.

Le TMDSLCDK1 38 remplace le
TMDXLCDK138 avec des performances,
des prix et des capacités identiques.
«  Il est disponible en quantité limitée

au fur et à mesure de l'augmentation

dustock», indique l'entreprise.

Le LCDK n'a pas d'émulateur embar-
qué. Un émulateur externe de TI
(comme le XDS1 00, XDS200, XDS51 0,
XDS560) ou celui d'un autre fabricant
sera nécessaire pour commencer le
développement.

http://www.linux.com/news/featured-blogs/204-mike-woster/867455-freescale-joins-real-time-linux-project-as-gold-member
http://venturebeat.com/2015/11/17/numecent-raises-15-5m-to-bring-cloudpaging-to-android-and-linux/
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ACTUS
Source :
http://www.electropages.com/201 5/
1 1 /texas-instruments-kit-enables-
fast-easy-linux-software-hardware-
development/

LAMISE AU POINT DE LINUX
ARRIVE DANSVISUALSTUDIO

M icrosoft a dévoilé en avant-
première une nouvelle extension

GDB de Visual Studio en conformité
avec leur effort constant pour rendre
Visual Studio compatible avec le plus
grand nombre possible d'environne-
ments de développement. Marc Good-
ner de Microsoft a donné les détails
de cette nouvelle compatibilité qui
sera disponible à partir Visual Studio
201 5 Community.

Une fois installée, cette extension
offre une nouvelle option de projet
en environnement Visual C++ Cross
Platform appelée « Makefile Project
(GDB) ». Une fois créée, un client SSH
sera nécessaire sur votre machine
locale ou votre hôte Windows pour
permettre la communication. Comme
l'explique Gooner, des certificats
doivent être générés pour assurer
une com-munication sûre, mais notez
bien que des pass phrases ne peuvent
être uti-lisées à ce moment-là, ce qui
justifie de générer des certificats

séparés à cette fin. Il vous faudra
aussi faire votre première connexion
en utilisant votre client SSH en dehors
de Visual Studio, de façon à ce que le
certificat soit accepté. Les connexions
suivantes peuvent être faites depuis
Visual Studio.

Source :
http://www.infoq.com/news/201 5/1 1
/vs-gdb

LEBEBOP 2 DEPARROTS : PLUS
PETIT, PLUS RAPIDE, PLUS FIABLE
ET AMÉLIORÉ PARLINUX

P arrot a dévoilé à San Francisco
une version plus petite, plus ra-

pide et durant plus longtemps de son
drone Bebop basé sur Linux, lui per-
mettant d'asseoir sa domination sur
le marché consommateur de milieu
de gamme. Une des principales nou-
veautés est la coupure d'urgence qui
arrête instantanément les moteurs des
quatre rotors dès qu'une pale ren-
contre un obstacle. La concentration
des efforts sur la sécurité a également
été à l'ordre du jour cette semaine
quand 3DR (Solo) et DJI (Phantom)
ont annoncé de nouvelles technologies
similaires permettant à leurs clients
d'éviter les zones aériennes interdites.
La société française Parrot a, dès le

début, été un leader dans les véhi-
cules aériens inhabités grand public
(UAV) avec son drone AR à quatre
rotors, qui était à mi-chemin entre les
jouets et le marché des produits pro-
fessionnels. Parrot détient également
une grosse part du marché des jouets
drone et robots avec des produits
comme le Roller Spider et le Jumping
Sumo de même qu'avec les nouvelles
lignes de mini drones Jumping, Air-
borne et Hydrofoil qui se vendent
entre 1 45 et 200 $.

Source :
http://linuxgizmos.com/parrots-
bebop-2-smaller-faster-longer-
lasting-linux-fortified/

ARDUINO RENCONTRE LINUX :
ARDUINO ANNONCE

SA PLATEFORME

DE TROISIÈME GÉNÉRATION

L a simplicité de la plateforme Ar-
duino, son architecture ouverte

et sa facilité d'utilisation en font l'ou-
til de développement embarqué le
plus populaire parmi les constructeurs.

Une troisième génération de cartes
Arduino fait maintenant son appari-
tion et contient deux processeurs. La
troisième génération de cartes comme

Arduino Yun incluent un microcon-
trôleur (MCU) et un microprocesseur
plus puissant (MPU) comparable à ceux
que l'on trouve dans les ordinateurs
et les appareils mobiles. Le MCU (habi-
tuellement un Atmel ATmega 32x)
supporte la fonctionnalité d'entrée/sortie
directe habituellement gérée par la
plateforme Arduino. Le MPU est basé
sur une architecture MIPS (comme
l'Atheros AR9331 ) et est assez puissant
pour supporter des applications écrites
en langage C/C++, Python et Java. Le
microprocesseur supporte également
divers protocoles de communication
(Wi-Fi, TC/IP, HTTP, etc.) et des ser-
vices Web (les chat, les courriels,
Twitter, AllJoyn, etc.).

Source :
http://electronics360.globalspec.com
/article/5995/arduino-meets-linux-
arduino-introduces-its-3rd-
generation-platform

http://www.electropages.com/2015/11/texas-instruments-kit-enables-fast-easy-linux-software-hardware-development/
http://www.infoq.com/news/2015/11/vs-gdb
http://linuxgizmos.com/parrots-bebop-2-smaller-faster-longer-lasting-linux-fortified/
http://electronics360.globalspec.com/article/5995/arduino-meets-linux-arduino-introduces-its-3rd-generation-platform
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L ast month, I wrote about Ubuntu
Phone, intending to follow up on

it this month. Unfortunately, I’ve
lacked the time to complete the
article for this issue – you can expect
it to be in next month’s issue. Instead,
I’ll discuss a new website creation
tool called ‘static site generation’. If
you’re not interested in websites, and
want to learn more about Ubuntu
Phone programming, check back next
month!

WHAT IS STATIC SITE

GENERATION?

Static site generators are
command-line tools that can take
content from formats such as
markdown and reStructuredText, and
insert the content into HTML
templates. At the most basic, you can
think of it as a content management
system that, when compiled, doesn’t
save content to a database, but
straight into a static html page.

BUT… WHY?

Anyone who has had to work to

optimize a page for performance
knows that static sites load much
faster (and with less effort), because
there is no delay while querying the
database, or while running for-loops
to insert information. Naturally, some
sites lend themselves to content
management systems (really large
sites, sites with various editors and
moderators, or sites that need to
serve dynamic content). As is always
the case in web design, it’s a matter
of picking the right tool for the job, in
order to create the site as fast as
possible, to have it perform well, and
to avoid reinventing the wheel at
every turn.

BUT MY CMS SITE LOADS

QUICKLY?

It’s possible to have a site load
very quickly when being used with a
CMS, but this is generally the result of
a great deal of testing, and plenty of
performance tweaks.

A COMPARISON

Note: According to studies by
Google, any site that takes longer

than 1 second to load (on mobile,
mainly) will generally have users leave
due to the wait. Studies from Amazon
and Google also saw that an increase
of loading time of 1 second (say, for
example, from 400ms to 1 .4s) could
result in a drop of revenue between
1 4 and 1 8%.

A site I am working on was
originally created using Django CMS -
where it would load in about 61 2ms
from my local machine (with no
network latency, a quad core CPU,
and an SSD), which is perfectly
reasonable. Shifting it to an Nginx
server running uwsgi saw the load
times jump up to 700-800ms.
However, the more content that was
added to the page, the longer it
would take. Version 3.2 of Django
CMS seems to have improved on the
speed, but it is not, as of writing, at a
final release. The equivalent site
using Pelican (a static site generator)
loads in 402ms, and the only
optimization I have done so far is to
merge my CSS files. There is no
compression of any sort running, and
is being served only with python
http.server. As the site is a redesign
for my own company, and I will be the

only one managing it, I have no need
for a CMS – I could just as easily write
the HTML by hand. However, the
number of pages make it
unreasonable to create everything by
hand, which is where Pelican comes
in. I can manage my content easily in
reStructuredText (or, theoretically,
anyone who knows Markdown,
HTML, or reStructuredText), and can
assign various templates to the
pages, according to the meta
information. The resulting static site
can be hosted easily and quickly on
Nginx, and use less resources than a
Django CMS setup running Nginx,
uwsgi, and postgresql. Note: this is
not a criticism of Django CMS, as I
could probably optimize my approach
in order to reduce load times. A static
site generator simply reduces the
amount of optimization I need to
accomplish.

I ’M SOLD! WHERE DO I
START?

There are various static site
generators on offer. The most
common and well-known is Jekyll,
which is used for GitHub Pages,

CCOOMMMMAANNDD && CCOONNQQUUEERR
Écrit par Lucas Westermann

SSttaattiicc SSii ttee GGeenneerraattiioonn
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among other things. Jekyll uses the
Liquid templating language, and is
written in Ruby. I, however, am
currently using Pelican, and for two
main reasons:

It uses Jinja2 for templating,
which is the same as Django. Meaning
I could carry over existing templates
quickly.

It is written in Python, and so has
integrated translation options for
multilingual sites (using Jinja2 i1 8n).
As my site is always in English and
German, this was a big factor forme.

So, depending on what you’re
most comfortable with, you may
prefer Jekyll over Pelican, or a
number of other static site
generators over either. Use what
you’re comfortable with, as it will
help cut down the learning curve. If
you want to use plugins for automatic
integration of bootstrap (for
example), then I would recommend
checking the plugin options before
choosing a generator.

DOES THIS MEAN I CAN’T
USE FORMS, OR ANY

DYNAMIC CONTENT AT ALL?

Forms are essentially just HTML
that gets sent via POST (typically) to a

php file. If you use a combination of
Nginx and apache (or just apache),
you can still include a php file for
sending the information around.
Depending on what you mean by
dynamic content, it should be
possible too. iFrames or widgets from
other sites shouldn’t be an issue, or, if
you want to semi-dynamically create
a grid (for example), you can create
templates using for-loops to iterate
through information in order to insert
it into HTML. If you’re looking for
login areas and personalized HTML, a
CMS will probably be easier for this.

OKAY, I ’VE INSTALLED A

GENERATOR. WHAT NOW?

Now would be the time to check
the homepage and view the
documentation. As each generator
has a slightly different file structure,
and different commands to compile,
it’s necessary to check the
documentation. Once you’ve created
a project (most likely done with a
quickstart command), then it’s time
to create some sample content, and a
template (or to adjust an existing
template).

MY SITE IS DONE...DO I HAVE
TO BUY HOSTING?

Since static HTML is so easily
served, there are some offerings
where you can upload a site without
much trouble. For example, GitHub
Pages. Technically, you could even
host it in some fashion on Dropbox.
So, depending on your needs, you
may not need to pay for additional
hosting - or if you do, you’ll most
likely not need too powerful a server
to adequately serve the content.

SHOULD I OPTIMIZE?

Depending on how quickly your
site loads, you may not feel you need
to. My recommendation, at least, is to
optimize images and enable server
compression if your site is going to be
mobile-friendly. Assuming, of course,
that you’ve minimized your CSS and
JS already. You’ll most likely not need
to do every optimization you can for
that last 3% decrease in size, but
some basics are recommended.

I hope this article has been
interesting for anyone looking at, or
working on, a project where you keep
thinking “this site is almost too small
for a CMS, but too large for doing it
by hand!”. Or anyone interested in
creating a quick project website for
GitHub. If you have questions,
suggestions, or comments, you can

reach me at
lswest34+fcm@gmail.com.

FURTHER READING

Jekyll homepage:
https://jekyllrb.com/

Pelican:
https://github.com/getpelican/pelica
n

Lucas a appris tout ce qu'il sait en endom-
mageant régulièrement son système et
en n'ayant alors plus d'autre choix que
de trouver un moyen de le réparer. Vous
pouvez lui écrire à : lswest34@gmail.com.

mailto:lswest34+fcm@gmail.com
https://jekyllrb.com/
https://github.com/getpelican/pelican
mailto:lswest34@gmail.com
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TTUUTTOORRIIEELL
Écrit par Greg D. Walters PPyytthhoonn ddaannss llee mmoonnddee RRÉÉEELL

W elcome back to the new
direction of my Python series.

In case you missed last month, I am
changing the direction of this 5 year
series from teaching programming in
Python to what is called Physical
Computing using Python. When you
see the phrase 'Physical Computing',
think of buttons, LEDs, motors,
sensors (temperature, humidity,
motion sensors, barometric sensors,
etc.) and more. The reason I decided
to do this was that after 5 years, I
thought I had shown pretty much
everything that you needed for
“normal” computing, so let’s focus on
what I consider the future of small
computer programming and
microcontrollers.

This month, I will be going over
selecting a Raspberry Pi (yes there
are more) that will fit your goals,
installing an operating system onto
the SD card and starting the RPi for
the first time with the newOS.

Next month, we will start learning
to respond to switches and control
LEDs. In future articles, we will be
interfacing with sensors and the
Arduino micro-controller.

A BRIEF HISTORY OF THE RPI

Much of this information comes
from the official Raspberry Pi website
(http://www.raspberypi.org) and my
memory of buying my first RPi. When
the Raspberry Pi first came out, there
were two models – Model A+ and
Model B+. The decision tree was
fairly easy since the two different
versions fit a “simple or full feature”
mindset, as you can see in the gross
details presented below (They are
now called RPi 1 Models)…

In February 201 5, both of those
models were superseded by the RPi 2
Model B. It shares a good deal with
the RPi 1 B+, but has a 900 MHZ
Quad-core ARM Cortex-A7 CPI and

1 GB Ram.

You can find various models of the
RPi at any number of web retailers.
My humble suggestion is to get the
RPi 2 Model B if you can afford the
difference in the price between the
P1 Model B (it shouldn’t be that much
of a delta). Any of the code that we
create in the next few articles should
easily work with any version of the
RPi.

While you are searching the web
for your RPi, you will see various kits
and add-on modules like cameras,
servo controllers, motor controllers
and so on. At this point, the add-ons
won’t be needed, but we might use
some in the future, so if it is

something that you are interested in
use your own judgment. As to the
kits, here are some things you should
consider before you invest in the
“ultimate kits”. In the next few
articles, we will need :

• A Raspberry Pi computer.
• A power supply. For the P1 versions,
a 5 VDC 1 -1 .2 amp cell phone charger
with a micro USB connection (normal
for many smart phones today) will
work well. For the P2 version, I
strongly suggest that you get a
power supply that has an output of 5
VDC 2.5 amp power supply with a
micro USB connector.
• A USB Keyboard and Mouse. While
many places offer very small
keyboard/mouse combos, for
programming work and “normal”
computer use, you will want a full size
version of both. You can move to the
small wireless versions later on if you
decide to use the RPi for other uses
like a multimedia centre or expanded
home automation. Normally when I
work with the Pi, I use a VNC server
on the Pi and a VNC client on my linux
machine, so I don't have to have
multiple keyboards and mice on the
top ofmy desk.

http://www.raspberypi.org
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• A 4-8 GB SD Card that is Class 1 0.
Versions P1 A and B used SD cards.
P1 Model B+ and above have
switched over to a Micro-SD card only
support. Keep this in mind when
buying a specific version. Of course
you can use a bigger card. Officially
they say that testing has been done
with 32 GB cards and don’t see many
issues with most of the larger cards.
Please Be careful when buying SD
cards, since they are not all created
equal. Just because a cheap card is
marked “Class 1 0” doesn’t actually
mean that it is going to work like a
more expensive card.
• Some sort of Internet connection,
either USB Dongle or Ethernet cable.
• A HDMI monitor/television for
output and HDMI cable. If HDMI is
not available, the P1 A and B versions
provide a RCA Composite Video out
and 3.5mm Audio Out connector.
The P1 B+ version and later have
done away with the RCA Composite
Video connector and has replaced it
with a 3.5mm jack that combines
audio and video in one. You would
need a 3.5 mm to 3 RCA connectors
to connect to an older TV.
• Speakers or headphones (unless the
monitor or device you are using
supports HDMI audio).

While this is the “minimum”
requirement list for this article, for

our first project you SHOULD have
the following items available…

• Breadboard – The breadboard will
be needed to start working with add
on discrete components like LEDs,
resistors, switches, etc. without
having to do any soldering.
• GPIO interface board (header) and
Ribbon cable. This will connect the
GPIO pins from the RPi to the
breadboard. Check out
http://sparkfun.com or
http://www.Adafruit.com for this
item. The item you will want to look
at from Adafruit is called “Pi T-
Cobbler Plus”. Note that this
particular item will NOT work with
the RPi V1 A or B. It will only work
with the later versions. It is currently
about $8.00 U.S.. If you are using a
model A or B, you should get “Pi T-
Cobbler” which is about $7.00 U.S. If
you are looking at SparkFun, their
item is called the “Pi Wedge”. Unless
you want to assemble your own (read
this as soldering tiny parts), you will
want to get the Preassembled
version. This one costs about $1 0.00
U.S.. I believe that they have retired
(discontinued) the version for the RPi
1 A and 1 B. You CAN elect not to get
the interface board and ribbon cable
and use female (Pi side) to male
(breadboard side) jumpers. These will
work, however, in some of the things

we do later on, if you get the jumper
on the wrong pin of the Pi, it could
lead to damage to your Pi.
• Various Resistors, LEDs and Mini
pushbutton switches. I will give you a
list before we need them to give you
plenty of time to obtain them. You
can get these at many places.
• One other thing you might consider
is a case, but only if you have the
breakout boards and ribbon cables.
This will protect your Pi from your
handling of it.

SETUP OF YOUR RPI

Now comes what must be for me,
the most tedious part of the
project… the setup. The steps we
will perform are:

• Download the OS image.
• Unpack the image file from the
archive file. Put it somewhere it's
easy to get to.
• Installing OS to the SD Card.
• Getting the RPi hooked up.
• First boot of the RPi with the new
OS.

So, let’s get the OS image. Go to
the downloads page on the official
Raspberry Pi website
(https://www.raspberrypi.org/downl
oads). You will be presented multiple

versions of various images that you
can download, including 2 versions of
Ubuntu (The GUI version is Ubuntu
Mate), Windows 1 0 IOT and more. If
you have an older model (original
models A or B), neither of the Ubuntu
images or the Windows image will
run on these models. You need the
ARMV7 processor and the extra
memory to be able to use these
images.

The two we are interested in for
this project, are the NOOBS and the
RASPBIAN images. I will be using the
RASPBIAN Wheezy image dated 05-
05-201 5 for our first few projects, but
if you want to have the option of
booting into other OS images on the
same card, feel free to download the
NOOBS image. Just remember, if you
have more than one OS on the card,
you have less space available to the
RASPBIAN image and you will run
into an issue that I always used to, not
enough space for all the things you
want to try. Assuming that you are
doing your work on a Linux machine,
you can see the official installation
instructions at
https://www.raspberrypi.org/docume
ntation/installation/installing-
images/linux.md . If you are using a
Windows machine or a Mac, follow
the links there. I’m going to assume a
Linux machine and will give you the

http://sparkfun.com
http://www.Adafruit.com
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instructions here.

Before we get started, you might
be asking why, if there is a
newer/better version available, am I
using the older version. I’ve had
some trouble with the ‘Jessie’ release
and am more comfortable with the
‘Wheezy’ release at this time. I doubt
that this was an issue with the
release, probably just a bad
download, but I just wanted to let you
know. For the purpose of the next
few articles, use ‘Wheezy’ and feel
free to play with other versions.

Unpack the archive and have it be
sent to a folder that will be easy for
you to remember.

INSTALLING THE OS IMAGE

TO THE SD CARD

If you are using an early version of
the Pi, you will be using a standard
sized SD card. If you are using a later
version you will be using a Micro-SD
card. To save me having to type the
distinction every time, I will use “SD”
in the documentation. One more
thing before we start. I STRONGLY
SUGGEST that you do not use a
device connected to an external USB
hub for the imaging of the SD card. I
know the specs say you can, but I've

never had very good luck doing this.

OK, here we go. Before inserting
the SD card into your Linux box, open
a terminal and do:

sudo -i

Most of the commands don't
actually need the sudo level
permissions, but it won't hurt and
neither you or I have to remember
when they do. Now run “df -h” to see
what devices are currently mounted
in the system. My system responds as
shown below. Yes, I've named my
machine Slartibartfast.

Thank goodness! However
/dev/sde1 has two partitions. This
will be important in the next step. If
you are me, please write down the
drive information so you don't make a
mistake. Now you will want to
unmount the SD card drive.

Slartibartfast ~ # umount
/dev/sde2

Slartibartfast ~ # umount
/dev/sde1

Slartibartfast ~ # df -h

Notice that I started yet another
“df -h” just to verify that the device is
unmounted.

If you have ever used this SD card for anything before, you will want to

Slartibartfast ~ # df -h
Filesystem Size Used Avail Use% Mounted on
/dev/sda1 451G 336G 93G 79% /
none 4.0K 0 4.0K 0% /sys/fs/cgroup
udev 3.9G 4.0K 3.9G 1% /dev
tmpfs 796M 1.5M 794M 1% /run
none 5.0M 0 5.0M 0% /run/lock
none 3.9G 124M 3.8G 4% /run/shm
none 100M 32K 100M 1% /run/user
/dev/sdd1 2.8T 2.5T 314G 89% /media/greg/TOSHIBA
EXT
/dev/sdb1 1.8T 1.5T 294G 84% /media/greg/extramedia
/dev/sdc1 917G 681G 190G 79% /media/greg/MoreMedia2
Slartibartfast ~ #

Notice that I have 4 drives (sda1 , sdb1 , sdc1 and sdd1 ). I hope that when I plug
in the SD card, it will come up as /dev/sde1 . This will be important to know
because ifwe get the wrong /dev/ device, we will corrupt it! Now plug your SD
card into the computer and run “df-h” again. My system responds as:

Slartibartfast - # df-h
Filesystem Size Used Avail Use% Mounted on
/dev/sda1 451G 336G 93G 79% /
none 4.0K 0 4.0K 0% /sys/fs/cgroup
udev 3.9G 4.0K 3.9G 1% /dev
tmpfs 796M 1.5M 794M 1% /run
none 5.0M 0 5.0M 0% /run/lock
none 3.9G 124M 3.8G 4% /run/shm
none 100M 36K 100M 1% /run/user
/dev/sdd1 2.8T 2.5T 314G 89% /media/greg/TOSHIBA
EXT
/dev/sdb1 1.8T 1.5T 294G 84% /media/greg/extramedia
/dev/sdc1 917G 681G 190G 79% /media/greg/MoreMedia2
/dev/sde1 56M 20M 37M 36% /media/greg/boot
/dev/sde2 30G 3.0G 25G 11% /media/greg/13d368bf-
6dbf-4751-8ba1-88bed06bef77
Slartibartfast - #

https://www.raspberrypi.org/documentation/installation/installing-images/linux.md
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remove the partitions before
proceeding further. Some people
might argue that this is not necessary,
but why not? It only takes a few
seconds and it keeps us from having
problems. Use “gparted” to remove
all the partitions.

We are about to write the
Raspbian image to the SD card. There
are two ways to do this. First is to use
the “dd” command AS SUDO, which
I'm sure will be the first thing that
comes to everyone's mind. However,
remember when we use “dd”, we
don't get any information coming
back to tell us what is going on and if
it takes 5 minutes or longer to write
the image, we won't see anything
that entire time in the way of
progress. While there are other
methods I'm going to suggest that
instead, you can use the “dcfldd”
command (shown top right). Once it
gets started (which could take a
minute or so) it will give a progress
report about how much has been
written. Pick your “weapon” of
choice. I'm going to show “dcfldd”.

Now, as SUDO, please change to
where ever you have unpacked the
image you are going to use.

I show (below) an “ls” command
here. I do this so I can remember the
name of the file that I'm just about to
work with, and I have the exact
spelling.

On my machine, the process took
about 1 0 minutes total.

This next step (above) is totally
optional, but if you are like me, you
want to verify the write so that you
can be sure that this matches the
image. We will make an image of the
SD card we just did and write it to a
temporary image file back to the hard
drive. Since your SD card will likely be
bigger than the one they used to
create the distribution image, we will
need to truncate our copy to match

the size of the original and finally use
diff to verify that both images are the
same. Remember this could take a
rather long time if you have a card
larger than about 8Gb. I'm using a
32Gb card and it looks like it's going
to take probably 30+ minutes to copy
the image to the drive.

As you can see, the images are the
same, so if there is anything wrong
from here until we log in, it's not our
fault. This process could be a useful
process as you go along and want to

make a backup image of your Pi's
“drive”, just in case something
happens.

Finally, we want to run the sync
command which will make sure that
anything remains uncommitted in the
write cache is flushed and that is ok
to unmount the SD card.

Now we can move on to some
more “exciting” things. Powering on
the Pi.

GETTING READY TO POWER

UP YOUR RPI

Notice how I worded the heading
for this portion of the instructions.

Slartibartfast Raspbian # ls -al
total 7424016
drwxr-xr-x 2 greg greg 4096 Oct 31 12:02 .
drwxr-xr-x 3 greg greg 4096 Oct 23 20:11 ..
-rw-r--r-- 1 greg greg 3276800000 May 7 2015 2015-05-05-raspbian-wheezy.img
-rw-r--r-- 1 greg greg 4325376000 Sep 24 16:14 2015-09-24-raspbian-jessie.img
Slartibartfast Raspbian #

Slartibartfast Raspbian # dcfldd bs=4M if=2015-05-05-raspbian-wheezy.img of=/dev/sde
768 blocks (3072Mb) written.
781+1 records in
781+1 records out
Slartibartfast Raspbian #

Slartibartfast Raspbian # dd bs=4M if=/dev/sde of=wheezy-
2015-11-07.imgsafe
7609+1 records in
7609+1 records out
31914983424 bytes (32 GB) copied, 1675.51 s, 19.0 MB/s
Slartibartfast Raspbian # truncate --reference 2015-05-05-
raspbian-wheezy.img wheezy-2015-11-07.imgsafe
Slartibartfast Raspbian # diff -s wheezy-2015-11-07.imgsafe
2015-05-05-raspbian-wheezy.img
Files wheezy-2015-11-07.imgsafe and 2015-05-05-raspbian-
wheezy.img are identical
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There are certain things you should
do before you apply power to your
RPi. There are possibilities you can
damage your RPi if you don't do the
steps in order.

Plug in the Keyboard and Mouse
into the USB port/ports.

Plug in the Ethernet cable into the
Ethernet port or Wireless dongle into
the USB Port.

Switch on your monitor or TV and
get it set to the proper mode (HDMI
or Composite).

Plug in the video cable (HDMI or
Composite).

Put the SD card (or Micro-SD card)
into place. It doesn't matter if you are
using a full size SD card or a Micro-SD,
you will insert it with the label facing
down, not up towards the bottom of
the Pi. And whatever you do, DO
NOT remove the SD card while the
RPi is powered on.

At this point, we are ready to plug
in the power, so take a deep breath
and cross your body parts. Plug it in.

If it worked, then we'll move on. If
not, please retry the instructions
above.

Once you get Pi booted into a
distribution for the first time, you will
presented with the raspi-config
application. We are going to want to
tweak some of the settings. We only
really need to do this once.

You will see a screen with 9
options on it. We will work with
numbers 1 ,3 and 4.
• Option #1 - Asks about expanding
the file-system. You really want to do
this so you can get the most space
you can. It will take effect at the next
reboot.
• Option #3 - Enable boot to
Desktop/Scratch. You should go
ahead and set this to Desktop Login
as User 'Pi' at the Graphical Desktop.
• Option #4 – This sets various things
that we take for granted by our
automated setup systems. They
include Locale, Timezone and
Keyboard Layouts.

• First select Locale. Since this
computer comes from the UK, its
default is to select things that
someone living there would need. I,
on the other hand, need to change
some settings. I have to let the
window scroll down to EN_US.UTF-8
UTF-8 and select it. Follow the
prompts and you'll be fine.

• Next I need to set my time-zone.
Since I live in Colorado, USA, I would

select America under the Geographic
area, and Denver for the Time Zone.

• Finally I have to select the
keyboard layout I wish to use. It asks
a lot of questions, so I would select
“Generic”, “US”, “US”, “Default”, ”No
Compose Key” and “No” to Xserver
Termination key.

Finally I'm ready to set it up, so I
select “Finish” and “yes”. Your Pi
should reboot and you should see the
normal desktop. Now we want to
update the system to the latest, add
a couple of applications that we'll
need right away and then let it
reboot once again.

Open a terminal off the top menu
bar and do:

sudo apt-get update

sudo apt-get dist-upgrade

Now we want to install
TightVNCServer. While this is an
optional step, I find it much more
constructive to use the Remote
window on my Linux desktop than be
forced to have 2 monitors, keyboards
and mice. It always gets me confused
about what/where I am.

sudo apt-get install
tightvncserver

Once that's set up, it will ask you
to create a password, so no one can
just jump into your screen. Make it
easy for you to remember.

The very next thing we want to do
is set the tightvncserver to
automatically startup on boot. That
way we don't have to have a mouse
or a keyboard.

• Change to the home directory if you
aren't already there.
$ cd /home/pi

• Next, change to the .config
directory.
$ cd .config

• Now we will make a new directory
here called 'autostart'.
$ mkdir autostart

• Change to the autostart directory
we just created.
$ cd autostart

• Now create a new configuration file.
$ nano tightvnc.desktop
And enter the following lines:
[Desktop Entry]
Type=Application
Name=TightVNC
Exec=vncserver :1
StartupNotify=false

• Save the file (^O) and exit (^X).

Almost done now. The last thing
we will need to do is install the IDE
we will be using for our code
development, which is Geany.
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sudo apt-get install geany

Move over to your normal
computer and load VNCViewer
software on it. Once that's all done,
you will probably want to spend a
moment or two by rebooting the
computer and making sure that the
VNC really did start up and connect.
If everything works, you are done.

You will need (as I said earlier) a
few things for next month. Some
male to male jumpers, female to
female jumpers, the breadboard,
interface and cable and a handful of
things from the electronics store…

• Some small LEDs. Try to get around
1 0 of each Red, Green, Yellow and
Clear.
• Some small ¼ watt resistors. 220
ohm, 4.7K ohm, 1 0K ohm, and some
other “normal” hobbyist resistors.
About 1 0 each will do you and the
salesperson at the local shop should
be able to get you what you need.
• A couple of small switches (spst)
that will fit on the breadboard.
(usually comes with 4 pins).

Really that's about all you will
need for the next article. In the
meantime, enjoy playing with Linux
on the Pi. I think you will be surprised
by the power of this tiny device.

So until next month, the last
thought I will leave you with is
something we hear here in the U.S. all
the time...

“Butwait… there'smore!!!!!!!”

Greg Walters est propriétaire de Rainy-
Day Solutions LLC, une société de con-
sultants à Aurora au Colorado, et pro-
gramme depuis 1 972. Il aime faire la
cuisine, marcher, la musique et passer
du temps avec sa famille. Son site web
est www.thedesignatedgeek.net.

Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers déve-
loppements passionnants sur lesquels
ils travaillent, de telle façon que
nous pouvons tous comprendre !
Nous parlons aussi de la commu-
nauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://www.thedesignatedgeek.net
http://podcast.ubuntu-uk.org/
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Q uand vous avez des chiffres à
analyser, est-ce que vous chargez

ces données dans un tableur, forma-
tez la feuille, puis passez des heures à
fixer les nombres pour comprendre
ce qu'ils signifient ? Non ! Vous créez
un graphique qui représente les don-
nées. Alors qu'un graphique peut vous
aider à voir le résultat global de ces
données, comment examiner la façon
dont des valeurs individuelles rentrent
dans le schéma général ? Le formatage
conditionnel peut vous aider à vous
concentrer sur les valeurs qui consti-
tuent l'ensemble de données.

LibreOffice nous fournit de nom-
breuses options différentes de forma-
tage conditionnel, nous permettant de
trouver un réglage qui fonctionnera
pour beaucoup de types de données
différents. L'une des méthodes condi-
tionnelles a été présentée dans la
partie 43 sur les fonctions statistiques
(le FCM n° 91 ). Aujourd'hui, je veux
ajouter trois options supplémentaires
de formatage conditionnel à votre arse-
nal d'analyses de données : l'Échelle
de couleurs, la Barre de données et le
Jeu d'icônes.

METHODES DE CALCUL

Dans les trois méthodes, vous créez
une plage ou condition pour vos don-
nées. La plage ou condition est con-
trôlée par 6 différentes méthodes de
calcul des valeurs. Regardons chacune
d'elles :

Dans les trois méthodes, vous créez
une plage ou condition pour vos don-
nées. La plage ou condition est contrô-
lée par six différentes méthodes de
calcul des valeurs. Regardons chacune
d'elles :
••Minimum - La valeur la plus petite
de l'ensemble de données.
••Maximum - La valeur la plus grande
de l'ensemble de données.
••Centile - Le rang en centièmes de
chaque valeur dans la plage du mini-
mum au maximum des points de don-
nées.
••Valeur - La valeur est basée sur un
nombre fixe que vous saisissez.
••Pourcentage - La part qu'a chaque
valeur dans la somme globale de l'en-
semble de données.
••Formule - La valeur est fixée en réfé-
rence à une cellule ou une formule.

Bien que le centile et le pourcen-
tage puissent sembler identiques, ils

sont mathématiquement différents.
Le centile divise la différence entre

maximum et minimum en cent parties
et indique où sont placées les valeurs
dans ces 1 00 parties. Un pourcentage
indique l'importance d'une valeur
dans la somme de toutes les valeurs
du jeu.

ÉCHELLE DE COULEURS

L'Échelle de couleurs est un for-
matage conditionnel qui surligne les
valeurs dans un dégradé de couleurs
sélectionnées en fonction de leur
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valeur. Cette méthode vous donne un
indice visuel rapide sur la position de
la valeur dans l'ensemble. Vous pou-
vez utiliser 2 ou 3 couleurs pour créer
votre échelle. Je montrerai les deux.

Nous allons préparer une plage de
valeurs pour montrer comment l'échelle
fonctionne. La plage que nous allons
créer est linéaire, de sorte que vous
pourrez voir la façon dont les cou-
leurs varient d'une valeur à l'autre.
Commencez par entrer la valeur 1 dans
la cellule A1 . Sélectionnez la plage de
cellules A1 :A1 0. Édition > Remplir >
Série. Dans la boîte de dialogue, sélec-
tionnez Bas pour la direction, Arith-
métique pour le type de série et 1 0
pour l'incrément. Cliquez sur OK. Les
valeurs sont placées dans les cellules.
Maintenant, sélectionnez la plage
A1 :J1 0. Édition > Remplir > Série.
Sélectionnez Droite pour la direction,
Arithmétique pour le type de série et
1 pour l'incrément. Cliquez sur OK. Si
vous avez tout fait correctement, vous
aurez des valeurs de 1 à 1 00 dans les
1 0 lignes.

Maintenant, réglons notre Échelle
de couleurs. Si ce n'est pas déjà fait,
sélectionnez la plage A1 :J1 0. Format >
Formatage conditionnel > Échelle de
couleurs. La boîte Échelle de couleurs
est toujours préréglée à Toutes les
cellules. Dans la liste déroulante du
champ en haut au centre, choisissez
Échelle de couleurs (2 entrées). Laissez
les autres champs à leurs valeurs par
défaut. Cliquez sur OK. Notez que la
plage de nombres est surlignée avec
un dégradé de couleurs, commençant
sur un rouge standard, se mélangeant
de plus en plus à du bleu jusqu'au
milieu, puis perdant peu à peu du rouge
pour obtenir le bleu à la fin. Ainsi,
vous pouvez voir ici comment fonc-
tionne l'échelle de couleurs. Si votre
nombre est surligné avec une couleur
violacée, vous savez que c'est une
valeur du milieu. Plus c'est rouge, plus
la valeur est proche du début ; et plus
c'est bleu, plus elle est près de la fin.

Nous pouvons ajouter une troisième
couleur à l'échelle, ce qui augmente
l'effet visuel. Format > Formatage
conditionnel > Gérer. Sélectionnez la

condition dans la liste et cliquez sur
Éditer. Modifiez le champ en haut au
centre pour Échelle de couleurs (3
entrées). Les trois champs du milieu
sont liés à la troisième couleur. Sélec-
tionnez Centile pour le type, 50 pour
la valeur et Vert 3 pour la couleur.
Cliquez sur OK. Cliquez à nouveau sur
OK pour fermer la boîte de dialogue
Gérer le formatage conditionnel. Vous
avez maintenant deux dégradés de
couleurs. Du rouge au vert, du vert au
bleu. Plus vous avez de vert, plus vous
êtes proches du centre. Le formatage
en blanc des caractères des cellules
pourrait aider à mieux les distinguer
sur le fond coloré.

BARRES DE DONNÉES

Les Barres de données sont comme
un graphique vite fait dans la feuille,
créant un mélange de données et de gra-
phique. L'élargissement des colonnes
aide pour que les barres de données
aient un bel aspect. Nous placerons
nos données pour les Barres de
données à la suite de notre table
précédente, pour que vous puissiez le
faire.

Pour préparer les données pour
les Barres de données, sélectionnez la
plage de cellules L1 :L1 1 . Édition >
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Remplir > Série. Dans la boîte de dia-
logue Remplir, sélectionnez Bas pour
la direction, Arithmétique pour le type
de remplissage, -50 pour la valeur de
début et 1 0 pour l'incrément. Cliquez
sur OK. Les données vont remplir les
cellules de -50 à 50 par incréments de
1 0.

Pour créer les Barres de données,
sélectionnez la plage L1 :L1 1 . Format
> Formatage conditionnel > Barre de
données. Comme pour l'Échelle de
couleurs, ne modifiez pas les valeurs
de tous les champs. Vous pouvez uti-
liser n'importe quelle méthode de calcul

pour créer votre plage basse et votre
plage haute, mais en laissant en auto-
matique, vous afficherez les meilleurs
résultats pour vos données. Cliquez
sur OK. Vous verrez que les données
sont séparées en deux. Les nombres
négatifs croissent vers la gauche en
rouge et les nombres positifs croissent
vers la droite en bleu. Notez l'échelle
en dégradé pour les deux couleurs.

Mais ce n'est pas la fin de notre
histoire. Avez-vous remarqué le bou-
ton Plus d'options… ? Peut-être même
que vous l'avez cliqué. Vous êtes le
gars qui aime aller de l'avant, n'est-ce
pas ? Bien, revenons en arrière et jetons
un regard à ces options. Éditons notre
plage de Barres de données, Format >
Formatage conditionnel > Gérer. Sélec-
tionnez la plage des barres de données
(L1 ;L1 1 ) et cliquez sur le bouton Édi-
ter. Enfin, cliquez sur le bouton Plus
d'options…

Ici, vous pouvez ajuster le minimum
et le maximum, comme dans la boîte
de dialogue. Les options Couleurs de
barre vous permettent de changer les
couleurs des nombres positifs et né-
gatifs. Le champ Remplir [Ndt : dans
la version 5] vous permet de changer
de Dégradé à Couleur (pleine). Le
choix de Axe vertical modifie la posi-
tion de la ligne, au centre ou à zéro
(gauche). Automatique ajustera sa posi-

tion en fonction du type de nombres
que vous avez. Pour les nombres posi-
tifs, il justifie automatiquement les
barres à gauche ; pour les nombres
négatifs, il les cale à droite. Pour un
mélange de nombres négatifs et posi-
tifs, Automatique centre l'axe zéro,
Milieu force l'axe vertical au centre
des cellules, Aucun force un calage
des barres à gauche, même pour les
nombres négatifs. Avec Aucun, la cou-
leur est la seule façon de distinguer
les nombres négatifs des positifs. L'uti-

lisation de Milieu ou Aucun pour l'axe
vertical active le champ Longueur des
barres [version 5]. Ici, vous pouvez
ajuster les longueurs minimum et
maximum, en pourcentage. Si vous
voulez qu'il y ait une barre pour chaque
valeur (sauf pour zéro), mettez 1 en
minimum. Ou, si vous ne voulez pas
que les barres aillent d'un bout à
l'autre, vous pouvez mettre le maxi-
mum à valeur différente de 1 00 (di-
sons 80). Amusez-vous avec ces options

pour voir les différents résultats. La
case à cocher Afficher seulement la
barre entraîne la visualisation des
barres seules, sans les valeurs.

JEUX D'ICÔNES

Les jeux d'icônes sont utilisés pour
montrer si une valeur est en dessous
de, égale à ou au-dessus d'une valeur
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définie. Les jeux d'icônes existent en
plusieurs variétés et en jeux de 3, 4
ou 5 icônes. Utilisez-les suivant le
style et le nombre d'icônes dont vous
avez besoin. Nous allons mettre en
place des nombres aléatoires, en faire
la moyenne, et ensuite, utiliser trois
icônes flèches pour déterminer si ces
valeurs sont en dessous ou au-dessus
de la moyenne.

En préparation, sélectionnez la plage
de cellules A1 3:A24. Édition > Rem-
plir > Nombre aléatoire. Prenez Entier
uniforme pour Distribution, 50 pour
Minimum, et 50 000 pour Maximum.
Cliquez sur OK. Dans la cellule C1 3,
entrez la formule :
=MOYENNE(A1 3:A24).

Pour régler les icônes, sélectio-
nnez la plage A1 3:A24. Format > For-
matage conditionnel > Jeu d'icônes.
Changez les deux champs à liste dé-
roulante pour la méthode Formule.
Dans le premier champ de saisie, face
à la flèche jaune pointant à droite,
entrez la formule =C1 3. Si la valeur de
la cellule est égale à la valeur en C1 3,
la flèche jaune sera affichée dans la
cellule. Si la valeur de la cellule est
plus petite que la valeur de C1 3, la
cellule comportera la flèche rouge
descendante. Dans le second champ
de saisie, entrez la formule =PLA-
FOND(C1 3;1 ;0). La fonction PLAFOND

(CEILING en anglais) prend le nombre
fourni, dans notre cas la valeur dans la
cellule C1 3, et l'arrondit par valeur
supérieure en fonction de la valeur du
second argument. Comme nous avons
1 comme second argument, la fonc-
tion fera l'arrondi au prochain nom-
bre entier supérieur. Le troisième argu-
ment, mis à 0 dans notre cas, contrôle
si les nombres négatifs sont arrondis
suivant leur valeur réelle ou leur va-
leur absolue. Pour arrondir à partir de
la valeur absolue, vous auriez mis le
troisième argument à quelque chose
d'autre que zéro. Cliquez sur le bou-
ton OK et les flèches seront affichées
dans les cellules en fonction de leur
position respective par rapport à la
valeur en C1 3.

Le formatage conditionnel nous
donne la possibilité d'obtenir des in-
dices visuels sur les valeurs présentes
dans la feuille de calcul, sans avoir à
créer un diagramme ou un graphique.
L'échelle de couleurs met une couleur
de fond dans une cellule, suivant sa
valeur dans une plage définie. Les

barres de données créent un mini
barre-graphe directement dans les cel-
lules. Le jeu d'icônes marque les cel-
lules avec des icônes sur la base de
leur relation conditionnelle à une va-
leur. Chaque méthode a sa fonction
propre, qui vous donne un style de ré-
sultat différent. Comme en créant un
diagramme ou un graphique, vous
devez décider celui qui fonctionne le
mieux pour votre utilisation.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

http://eeperry.wordpress.com
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F or this edition of the LaTeX
segment, I will tell you a little bit

about BibTeX and how it can help
you. To help liven up a dry subject, I’ll
compose an ultra-short paper, and I’ll
include information about that great
album by the Beatles: “Sgt. Pepper” –
that you probably did not know
about! But first... you need to know
about a bibliographic software called
Zotero.

Zotero is a plug-in for Firefox. To
describe it well, I will post a quote
here from the Zotero website:

“Zotero is the only research tool
that automatically senses content in

yourweb browser, allowing you to add

it to yourpersonal librarywith a single

click. Whether you're searching for a

pre-print on arXiv.org, a journal article

from JSTOR, a news story from the

New York Times, or a book from your

university library catalog, Zotero has

you covered with support for

thousandsofsites.”

And, just like LaTeX, there are
thousands of YouTube videos on how
to use Zotero. There are also very
good videos on how to create

citations and bibliographies.

What does Zotero do for you?
Suppose you are conducting research
for a term paper. You are searching
online for journal articles. When you
find one that is on point for your
paper, you can click a tiny icon on your
browser and all of the bibliographic
information that you need is
downloaded to your own database.
You also have the URL for the article,
and a copy of the article is
downloaded to your computer.
Zotero can download bibliographic
data for any book you find in a library
catalogue. Almost anything that you
find on the Internet can be
catalogued by Zotero, all with a click
of a mouse.

It is these little icons that do all

the magic for you:

Z opens the Zotero database; the
blue book icon
downloads the
bibliographic
information – note that different
icons appear for various types of
media.

So where is the connection to
LaTeX? And BibTeX?

Zotero will export your data in
many forms, one of them is the
BibTeX format and it looks like this:

@Book{ID,
ALTauthor = {author},
ALTeditor = {editor},
title = {title},
publisher = {publisher},
year = {year},

OPTkey = {key},
OPTvolume = {volume},
OPTnumber = {number},
OPTseries = {series},
OPTaddress = {address},
OPTedition = {edition},
OPTmonth = {month},
OPTnote = {note},
OPTannote = {annote},
}

Many LaTeX editors will create the
appropriate template for the item
you wish to record. Quite simple to
use, inside the { } we just type in the
information required. The most
important field is the field on the first
line. “ID” must be a unique identifier
or “key”. So, for a book I would have
written, the key could be “jek201 5”.

It would be tedious to type in all
of that information, but at least this
way you have to type it only once. But

@book{martin_little_1994,
address = {Boston},
edition = {1st U.S. ed},
title = {With a little help from my friends: the making of {Sgt}. {Pepper}},
isbn = {978-0-316-54783-3},
shorttitle = {With a little help from my friends},
publisher = {Little, Brown},
author = {Martin, George and Pearson, William},
year = {1994},
keywords = {1961-1970, Beatles, England, Rock music},
annote = {Includes index}

}
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Zotero can do all of that for you, here
(previous page, bottom right) is a
citation that I harvested from the
catalogue at my local library with a
click on the blue icon in my browser.

All that typing was done for you
with a click of a mouse way back
when you were searching the library
online catalogue. To export the
record, highlight the record (multiple
records can be done by holding down
the ctrl-key while you click on other
records required for the
bibliography).

Right click and choose Export
Items, scroll in the next window to
BibTeX, then click OK.

Sometimes we may want to tweak
the records. I would change:

martin_little _1994

to

gmartin94.

@book{gmartin94,
address = {Boston},
edition = {1st U.S. ed},

Unfortunately, we can edit the
record key only in the BibTeX file, not
the Zotero file. So if you have a
BibTeX file that you have modified,
and then you want to add another
record, you will have to export that
record to its own file and then copy
and paste the data into the main
BibTeX file.

Now, sometimes we have to
manually enter records, I find that for
recording websites, Zotero does a
great job but the BibTeX output can
enter many excess '{ }' that have to be
edited out. Just a warning.

Here is a record that I created, to

record a conversation I had with one
of the pioneers of FM rock, David
Marsden of the Internet radio station
https://www.nythespirit.com:

@misc{_interview_????,

title = {Interview : {David}
{Marsden}},

url =
{https://www.nythespirit.com/
},

publisher = {unpublished},

annote = {When I heard
Sargent Pepper I knew that
rock music had to move to the
FM band because AM just could
not deliver the sound that
the rock musicians were
making. At that time, the FM
band was the sacred ground of
classical music. It was a
tough fight and it took a
year for it to happen.}

}

The annote field is a good place to
enter any text that you want to quote
in your paper.

SO HOW DO WE GET THIS ALL

TO WORK?

The bibliography file must end
with the letters bib (Zotero does that
for you), and must also be in the same

directory as the file that your
document is in. (Creating a directory
for your LaTeX document is the first
rule of LaTeX).

The bibliographic file in this
project is called Pepper.bib.

In the preamble add this line:

\bibliographystyle{plain}

To your document at the end, just
before /end{document}, add this line:

\bibliography{the name of
your file.bib}

or in this case:

\bibliography{Pepper.bib}.

The name of the file is case
sensitive so make sure that you type
the name of the file exactly.

There are many bibliography
styles to choose from but I will just
use the plain style in my ultra-short
paper. Here are some sites that cover
the bibliography style in more detail,
with examples:
http://www.cs.stir.ac.uk/~kjt/softwar
e/latex/showbst.html
http://www.reed.edu/cis/help/LaTeX/
bibtexstyles.html#seven

https://www.nythespirit.com
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Many colleges and universities

have information regarding
bibliographic styles, and also LaTeX
templates for a thesis, on their
websites; enquire at the institution
you are attending.

Whenever you want to cite a
source in your paper, type \cite and
your LaTeX editor should list the
citations in your BibTeX file for you to
insert:

The bibliography is created when
you compile your document and it all
will look something like this:

Sometimes you may have to
compile your document more than

once to get the bibliography to
compile, that can be normal.

This article has just scraped the
surface of the bibliography
component of LaTeX. There are other
ways of approaching this, and there

are many other options in the BibTex
bag of tricks. There is a new format
called BibLateX, and Zotero will
export bibliographies in this format as
well. However I must say that –
thanks to the BibTex export feature
that we have in Zotero, and that
Zotero makes data harvesting from
databases so easy – I am in favour of
the BibTex file method which is
creating a .bib file of your references
that resides in the directory of the
document you are creating.

I wish I had LaTeX and BibTeX way
back in the days when I was writing
my papers at University, back in the
days when FM stereo was about as
high tech as it got. Today, with a little

help from your friends (all those
people who have created the free
software), writing a class paper is so
much easier. I am green with envy.

A shameless plug is in order. If you
would like to hear what FM Rock
radio was like in the early years when
the DJ's could practise Free Form FM
radio (that was before the suits
discovered there was more
advertising revenue to extract), I
encourage you to explore David
Marsden's own show on Saturday and
Sunday nights 8:00 pm Eastern time
at this site:
https://www.nythespirit.com/. Code
“BEMX” will give you a one-month
free trial.

By now I suppose the suspense is
killing you, and you have to know the
identity of the real Sgt. Pepper. He
was a policeman who was on the
security team when the Beatles
visited Toronto. That morsel of
information is on the last page of Sir
George Martin's book which is full of
interesting tidbits. It is a must read, I
enjoyed it. Until next time, enjoy
LaTeX.

http://www.cs.stir.ac.uk/~kjt/software/latex/showbst.html
http://www.reed.edu/cis/help/LaTeX/bibtexstyles.html#seven
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Écrit par Attila-Mihály Balázs

PPrrooggrraammmmeezz

P rogramming is an activity where
you need to continuously learn

to stay productive. Programming
languages, libraries, tools, operating
systems - they all change. This means
that last year’s solutions that you find
on the Internet might not be
applicable this year. Thus we need
new content (be it blog posts,
documentation, books or other
forms) showing the current best way
to achieve a given goal. One solution
is StackOverflow with its voting
system (where out-of-date solutions
get voted down and working
solutions get voted up) and others
are blogs. The problem with blogs is
that people rarely have time to blog
frequently and/or don’t have
expertise and a diverse set of
domains, thus readership interest can
waver. There are tries to encourage
people to blog regularly (such as the
Perl Iron Man Blogging Challenge),
however, it is easier to sustain a blog
with multiple authors (also called
collaborative blogging).

A programming Advent calendar
is such a collaborative blog centering
around one language / framework /
library or subsection of the IT field.

Just as you open one door of an
Advent calendar every day between
the 1 st and 24th of December to find
a surprise, these blogs publish one
article each day for the first 24 days
of December about their respective
topics surprising, informing and
delighting their readers.

Some of the programming Advent
calendars are:

JAVA ADVENT CALENDAR
http://www.javaadvent.com/

I’m partial to this, having started it 4
years ago :-). It contains articles about
all kinds of technologies related to
the Java Virtual Machine, not just
Java the language. For example, we
had articles about two of the oldest
languages running on the JVM
(besides Java): NetRexx and Kawa.

THE PERL 6 ADVENT

CALENDAR
https://perl6advent.wordpress.com/

Perl 6 is a new programming
language to be released this
Christmas, so if you’re interested in

Perl 5, this is a good site to follow

PERLADVENT
http://www.perladvent.org/

If you’re not ready to make the jump
to Perl 6 yet (since it’s a completely
new language, not just a superset of
Perl 5), here you can find all kind of
interesting details about it.

24WAYS
https://24ways.org/

“24 ways is the Advent calendar for
web geeks. For twenty-four days each
December we publish a daily dose of
web design and development
goodness to bring you all a little
Christmas cheer.”

SYSADVENT
https://sysadvent.blogspot.com

Interesting articles for system
administrators and anyone curious
about the field of IT.

UXMAS
http://uxmas.com/

“An Advent calendar for UX folk.”

PERL DANCER ADVENT

CALENDAR
http://advent.perldancer.org

“The PerlDancer Advent Calendar is a
community-driven project that aims
to showcase the Dancer Perl web
framework.”

24 PULL REQUESTS
http://24pullrequests.com/

This isn’t a collaborative blog, but
rather an effort to encourage people
to contribute to free / open-source
software on GitHub

QI ITA ADVENT CALENDARS
http://qiita.com/advent-calendar

There are a lot of topics covered here
(and I mean a lot - in 201 4 they had
21 4 different Advent calendars with
different topics). Unfortunately, you
need to be able to read Japanese to
enjoy it.

http://www.javaadvent.com/
https://perl6advent.wordpress.com/
http://www.perladvent.org/
https://24ways.org/
https://sysadvent.blogspot.com
http://uxmas.com/
http://advent.perldancer.org
http://24pullrequests.com/
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These are the ones which are

currently active (there were others
which unfortunately are no longer
available).

You can subscribe to any of these
using your favorite RSS reader (for
example Liferea, RSSOwl, feedly,
NewsBlur and so on) to ensure that
you never miss a post. Some of them
(like JavaAdvent) also offer other
means of subscription (like Twitter,
Facebook, Google+ or even email).

Finally, all of these sites welcome
(and in fact depend on) user
contribution. So go ahead and
subscribe to them and also consider
writing an article or two yourself! As
they say: the best way to understand
something is to try to explain it to
others!

http://qiita.com/advent-calendar
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TTUUTTOORRIIEELL
Écrit par Mark Crutch II nnkkssccaappee -- PPaarrttiiee 4433

B efore we delve too much further
into Live Path Effects, there are

some implementation details that are
worth pointing out. The first is that
LPEs don't exist in the SVG
specification. They're an Inkscape-
specific thing, and no browser or
other SVG editor knows how to
render them. Go on, give it a try.
Create a nice chain of gears, or a Spiro
path, then save your SVG file. Open it
in a modern web browser and see
what you get. Here's my file, opened
in Firefox.

Well, it certainly looks like my
original Inkscape file, but how can
that be if the browser doesn't know
anything about LPEs? The answer can

be found by looking at the XML code
for the file, either via Inkscape's XML
editor (Edit > XML Editor, or CTRL-
SHIFT-X), by viewing the page source
in your browser (CTRL-U in Firefox),
or simply by opening your SVG file in
a text editor. You'll see that the main
body of the image is made up of an
SVG <path> element. The “d”
attribute contains a series of letters
and coordinates that tells an SVG-
aware application how to draw the
final path, after any visible LPEs have
been applied. It's like a snapshot of
the result, in a format that your
browser understands.

Notice that there are some other
attributes, in the “inkscape”
namespace. In particular you'll find
“inkscape:original-d”, which holds the
path definition of the original,
skeleton path. There's also an
“inkscape:path-effect” attribute,
which holds a semicolon-separated
list of XML IDs. These refer to
<inkscape:path-effect> elements up
in the <defs> section of the XML,
which is where all the parameters for
your effects are stored.

So, in summary, Inkscape uses the

“original-d” attribute and <path-
effect> elements to hold all the
information it needs to draw the LPE.
Other applications use the “d”
attribute to render a snapshot of the
final path, with the LPE applied.
When you modify an LPE within
Inkscape, it automatically updates the
“d” attribute to match the rendered
output, so other applications should
always be able to display your
drawing as intended, even though
they don't know anything about LPEs.

Inkscape doesn't always do a
great job of clearing out unused
elements in the <defs> section of a
file, and path effect definitions are no
exception. If you add and remove a
number of LPEs whilst experimenting
with your drawing, old definitions
tend to build up there. They don't do
any harm, but do slightly increase the
size of the file. You can clear them
out, together with other unused
definitions, by using the File > Clean
Up Document menu entry (File >
Vacuum Defs on 0.48).

Because Inkscape calculates the
final path from the original path and
LPE parameters, using live path

effects places more of a burden on
the processor, resulting in slower
rendering speeds. Usually this isn't an
issue, but when zooming into a very
complex drawing it can become
noticeable. If you're happy with the
LPE output, and don't need to change
it any further, you can “fix” the path
so that it looks the same, but is no
longer based on path effects.
Essentially this process just removes
the Inkscape-namespaced attributes
from the path element, leaving it with
just the same “d” attribute that any
other application uses. To do this,
simply use the Path > Object to Path
menu entry (CTRL-SHIFT-C). It may
seem odd to use Object to Path on
something that's already a path, but
think of it as converting an LPE path
to a plain SVG path, and it makes
more sense. Like any other Object to
Path conversion this is a strictly one-
way affair, so make sure you keep a
backup of the file from just before
the change, in case you subsequently
find you need to modify your LPE
parameters after all.

That's enough behind-the-scenes
detail for now, let's press on with
another path effect! As usual we'll
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need a path to work on, so let's start
by drawing a simple arrow shape.

The path effect we'll look at this
time is “Bend”, so add that to your
path following the instructions from
the previous instalment. As before,
there's no immediate change to your
image, but the LPE dialog has gained
a few controls at the bottom. Of
particular note is this quartet of

buttons:

This arrangement of buttons
appears frequently in LPEs, whenever
an extra path is required as part of
the input parameters. In the case of
the Bend effect, two paths are
required: the original skeleton path
(the arrow shape, in this case), and a
bend path whose shape dictates how
the skeleton path should be

distorted. These buttons are for
managing the bend path, as follows:

• The first button allows you to edit
the bend path directly on the canvas.

This is the most commonly used of
the four.
• The second button lets you copy the
bend path to the clipboard. From
there you can paste it into another
LPE, or even paste it directly into the
canvas as a new path in its own right.
These copies maintain no connection
to the original bend path.
• The third button is for pasting a path
to use as the bend path. This could be
one that you've copied from another
LPE using button two, or it could be a
path you've constructed elsewhere in
your canvas. Again, there's no
connection maintained to the original
path.
• The final button lets you link to an
existing path, rather than create a
new bend path. In this case there is a
live connection to the original path,
so any changes you make to that are
immediately reflected in the LPE. I'll
discuss this button in more detail a
little later.

If you press the first button you
should find that a straight green path
appears on the canvas, directly over
your skeleton path. This is the bend
path, and you can manipulate it in the
same way as any other. Try dragging
the path itself, or use the node
handles, to distort its shape, noticing
how the skeleton path is morphed in
real-time to match your changes. You

can also move the nodes themselves,
in order to stretch, compress or
rotate the skeleton path. If the bend
path disappears – usually due to a
mis-click causing the skeleton path to
become selected – just click on the
first button of the quartet in the LPE
dialog to make it reappear. With
barely any effort the Bend path
effect can turn your straight arrow
into a curved or sinuous shape that
would take a lot more time and work
to produce using normal path editing
techniques:

But there's more! Your bend path
doesn't have to be limited to a pair of
end nodes connected by a curve. You
can add extra nodes, turn them into
corners, mix straight and curved
sections, have the path double-back
on itself, or even split it into several
sub-paths. Admittedly, getting too
complex with your bend path can
lead to a degree of contortion that's
hard to control, but the options are
there for you to explore.

Using the second and third

buttons you can copy and paste the
bend path from one LPE to another,
which can be handy if you want
several skeleton paths all distorted in
the same way. Each bend path will be
an independent copy, though, so
changes to one won't affect the
others. Sometimes it's useful to have
multiple bend paths all linked to a
single “master” path, such that
changes to the shape of the master
are immediately reflected in each
individual LPE. The fourth button

allows you to achieve that effect, but
it's not without its difficulties.

For this example I'm going to use
two different kinds of arrow, and I
want to apply the Bend LPE to both
of them such that they follow the
shape of the green path at the
bottom of the image.

The first step is to select the green
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path and copy it to the clipboard. As
well as copying the path data itself,
Inkscape also stores a reference to
the original object. Next I need to
select one of the arrows, add the
Bend LPE, and click on the fourth
button to use the stored reference to
define the bend path. Clicking this
button has two immediate effects:
the arrow is distorted to match the
bend path, as expected, and the
arrow is moved to the same location
as the bend path – which is not what I
wanted! If I add a Bend LPE to the
second arrow and link that to the
bend path, that also gets moved. I've

got all the right shapes, but not
necessarily in the right locations.

At first this might seem like a fairly
trivial problem. Just drag the arrows
back to where you want them, right?
Unfortunately that doesn't work –
drag them away and they'll spring

right back to the location of the bend
path. Drag the bend path away, and
they both follow along after it. Being
able to link to a common path seems
a lot less useful if it means that your
linked shapes all have to sit on top of
each other.

Fortunately there are a couple of
ways around this problem. Inkscape
has a setting hidden away in Edit >
Preferences > Behaviour >
Transforms labelled as “Store
Transformation”, with options of

Optimised or Preserved (it's in File >
Inkscape Preferences > Transforms
on 0.48). Use Optimised and you'll see
the behaviour I've described above –
LPE paths strongly bound to their
linked bend path. Set it to Preserved,
however, and you can move them
around with impunity. Of course
there's a trade-off: Optimised results
in slightly smaller, more efficient files,
whereas Preserved potentially stores
additional data for any object that's
been transformed, not just the ones
that are causing us problems.

If you want to leave the setting as
Optimised, there is a second
alternative which allows you to add
extra data to just the problem paths.
It's a little counter-intuitive, but it
does the job perfectly: just select
your path and add a second Bend
effect to it. You don't even have to
modify the bend path – just adding
the effect is enough to let you drag
your path around independently of
the linked bend path once more.

Whichever approach you take, you
should now have two separate,
independently positioned arrows,
both of which are linked to the shape
of the master bend path. Modify that
path and you'll see the arrows shape
change accordingly. If you don't want
to see the bend path in your final
design, simply hide it behind another
object, set its opacity to 0 (use View >
Display Mode > Outline to find it
again) or just move it onto a hidden
layer.

The remaining controls for the
Bend LPE are fairly simple. The Width
spinbox lets you control the scaling of
the skeleton path, perpendicular to
the bend path. Play with it to see the
effect. The “Width in units of length”
checkbox has a slightly misleading
title: “keep width proportional to
length” would be a better name.
Check this, and the width of the path

is scaled as the length of the bend
path changes; leave it unchecked to
keep the width unchanged regardless
of the shape of the bend path or the
position of the end nodes. The final
checkbox is quite self-explanatory: if
you wish to bend a path that's more
vertical than horizontal (e.g. an
upwards facing arrow), then check
this box, otherwise you'll be
distorting along the width of the
shape, rather than its length.

The Bend LPE is one that's well
suited for use with text, to produce
the sort of “Word Art” effects so
beloved of parish newsletters in the
1 990s. Because LPEs won't work
directly on a text object, you first
have to perform the one-way
conversion of your text into a
complex path. Using Path > Object to
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Path will result in a group of
individual paths, one for each letter.
We really want a single path
encompassing the whole text, so it's
easier to use Path > Combine, which
will convert your text into paths, and
combine them into a single complex
shape, all as one operation. The final
result will be a group of one object,
so you'll probably want to ungroup as
well. From there you're free to add a
Bend effect and distort your text as
you would with any other path.

Before you race off to convert
your text into a path, however, it's
worth considering the downside: the
shape is no longer a text object, so
you can't subsequently edit the
content if you find a mistake. Often a
similar result can be obtained by
drawing a separate bend path, then
selecting both your text and path
before using Text > Put on Path. You
may need to manually kern some of
the characters to get the right result
(see part 1 1 ), but it has the distinct
advantage of keeping your text
editable. In this image the red text
was converted to a path and bent,
the green is the same text put onto a
copy of the bend path, and the blue is
the same as the green, but with some
manual kerning applied.

One noticeable difference
between the approaches is that the

LPE distorts the shape of the letters,
whereas text-on-a-path maintains
their original shapes. Sometimes the
distortion effect is desirable, in which
case I can only recommend that you
save a copy of the file just prior to
converting to a path, in case you do
need to edit it later.

Next time we'll move beyond
simple path bending and into the kind
of full-on distortions that can turn
some simple text into a 1 970s album
title, as we continue to look at
Inkscape's live path effects.

Mark a utilisé Inkscape pour créer trois
bandes dessinées, The Greys, Monsters,
Inked et Elvie, qui peuvent toutes être
trouvées à http://www.peppertop.com/

http://www.peppertop.com
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AARRDDUUIINNOO
Écrit par Ronnie Tucker

IIDDEE 11 ..66..66

L a première semaine de novembre
a apporté une mise à jour de l'IDE

(Integrated Development Environne-
ment - environnement de développe-
ment intégré) d'Arduino. La mise à jour
1 .6.6 résout l'impressionnant chiffre
de plus de 720 défauts.

LES MEILLEURES NOUVELLES

FONCTIONNALITÉS

Il y a plusieurs nouvelles fonction-
nalités (que je n'utiliserai probable-
ment jamais) telles qu'un outil en
ligne de commande, une nouvelle archi-
tecture modulaire, une quantité de
défauts résolus, etc. Mais pour moi
l'important est :

• Le traceur série. On parle maintenant
de ce qui peut me servir. En utilisant
une commande comme :

Serial.println(analogRead(A0))

vous pouvez voir évoluer des données
en temps réel d'une manière plus jolie
qu'un simple défilé de nombres.

C'est vraiment pratique d'avoir une
sortie de données vers un moniteur
série, mais être capable de les voir
d'une façon plus visuelle est un su-
perbe complément.

OUPS !
Après avoir dit du bien, je dois

indiquer qu'il y a aussi beaucoup de
commentaires traînant sur Internet
disant que la 1 .6.6 a des défauts
sérieux, voire même critiques pour
certains.

Aussi, si vous voulez VRAIMENT
appliquer la mise à jour, allez-y, vous
êtes prévenus qu'actuellement ce
n'est pas sans risques.

D'autres nouvelles d'Arduino : je viens
d'acheter un kit d'imprimante Rep-

RapFisherDelta3Dqui est en quelque
sorte alimentée par l'Arduino. Elle uti-
lise un circuit basé sur l'Arduino Due.
Aussi, le mois prochain ou le suivant,
attendez-vous à un article sur l'impres-
sion 3D dans la rubrique de l'Arduino.
J'espère faire quelques photos ou vidéos
au fur et à mesure de la construction
et, de plus, finir probablement par une
critique de cet appareil.

Ronnie est le fondateur et (toujours !)
le rédacteur en chef du Full Circle. C'est
le genre de personne qui fait de l'arti-
sanat de temps en temps ; actuel-
lement, il bricole avec Arduino.
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LLEE CCUULLTTEE DDEE CCHHRROOMMEE
Écrit par S. J. Webb CCoonnffiiddeennttiiaa llii ttéé

M on objectif était d'écrire un tuto-
riel sur comment faire du cryp-

tage avec le navigateur Chrome et l'app
Store. Mais les dernières nouvelles de
Google ont motivés mes commen-
taires impromptus. Chrome OS et An-
droid vont fusionner ce qui résultera
en un nouveau système d'exploitation.
L'OS bêta sera présenté en avant-
première en 201 6 et l'hybride d'un OS
de mobile et celui du Cloud naîtra. Il
sera prêt pour les consommateurs en
201 7. Il n'y a de détails ni sur le nom
de ce nouveau système d'exploitation,
ni sur le matériel qui lui sera associé.

Google a publié des rapports con-
tradictoires concernant le maintien du
système d'exploitation Chrome pour la
base de Chromebooks existants. Dans
un monde idéal, le nouveau système
d'exploitation hybride tournerait sur
les Chromebooks sans problème. Sinon,
j'utiliserai Crouton pour Ubuntu Mate.

Les gens sont divisés a propos de
cette décision. Ils croient que Google
est en train de tuer le Chromebook,
malgré sa croissance et sa popularité
constantes. D'autres estiment que c'est
une évolution naturelle de l'écosphère
Google. Google a déjà abandonné des

trucs impopulaires. Le système d'exploi-
tation Chrome est cependant trop po-
pulaire pour l'éliminer complètement.

Analysons les deux systèmes d'ex-
ploitation de Google indépendam-
ment : Android et Chrome. Android
est le premier OS sur les mobiles, avec
une forte présence de développeurs
d'application. Mais il est miné par ses
problèmes de sécurité et par le manque
de correctifs appropriés et dans des
délais convenables. Chrome est extrê-
mement sécurisé grâce au cryptage
du SSD en natif, au bac à sable pour
les applications Web et aux mises à
jour de sécurité toutes les 6 semaines.
Pourtant, la présence de dévelop-
peurs d'applications pour l'App Store
est beaucoup plus faible. Idéalement,
en fusionnant la sécurité de Chrome
OS et l'App Store d'Android, Google
obtiendra à la fois le volume et l'effi-
cacité. En publiant ce nouvel OS hy-
bride, Google aura plus d'utilisateurs
dans son écosphère.

Google a déjà commencé à créer
un prototype Android Chromebook,
appelé le Pixel C. Il offre les fonction-
nalités d'une tablette, mais avec un
clavier en option. Je crois que ce sera

le premier ordinateur qui fonction-
nera sous l'OS hybride.

Le prix du Pixel C est fixé autour
de 500 $. Cependant, il sera muni de
3  Go de RAM, d'un processeur Nvidia
Quadcore, d'un GPU Maxwell et d'un
SSD de 32 ou 64 Go. Le Pixel dépen-
dra toujours du WiFi. Cet appareil suit
la tendance des ventes de tablettes,
puisque les ventes d'ordinateurs de bu-
reau sont en baisse. Avec cet appareil,
Google sera toujours pertinent malgré
des tendances de consommation chan-
geantes.

Après avoir utilisé mon Chrome-
book pendant les derniers mois, je le
recommanderais comme ordinateur
de secours d'une distribution Linux ou
d'un MacBook. Et je recommanderais
mon Chromebook comme ordinateur
principal comparé à tout OS de Mi-
crosoft. Ça ne me dérange pas de
vivre dans le cloud du moment que
les limites sont connues. Je soupçonne
qu'un appareil « à la Chromebook »
sera le premier ordinateur portable
de mon gosse. J'apprends à m'adap-
ter à mon Chromebook. Sans aucun
doute, j'apprendrai à m'adapter au
nouvel OS prévu pour 201 7. Pour l'ins-

tant, la rubrique Culte de Chrome
continuera d'analyser l'expérience de
l'informatique en nuage.

SJ Webb est passionné de Linux et coor-
donnateur de recherche. Il aime pêcher,
conduire des bolides et passer du temps
avec ses enfants et sa femme. Il remer-
cie Mike Ferrari pour son mentorat.
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TTUUTTOORRIIEELL
Écrit par Ronnie Tucker ÉÉccrriirree ppoouurr llee FFuullll CCiirrccllee MMaaggaazziinnee

Lignes directrices

N otre seule règle : tout article doit avoir
un quelconque rapport avec Ubuntu

ou avec l'une de ses dérivées (Kubuntu,
Xubuntu, Lubuntu, etc.).

Autres règles
••Les articles ne sont pas limités en mots,
mais il faut savoir que de longs articles
peuvent paraître comme série dans plu-
sieurs numéros.

• Pour des conseils, veuillez vous référer au
guide officielOfficialFullCircleStyleGuide ici :
http://url.fullcirclemagazine.org/75d471

• Utilisez n'importe quel logiciel de traite-
ment de texte pour écrire votre article – je
recommande LibreOffice –, mais le plus impor-
tant est d'en VÉRIFIER L'ORTHOGRAPHE ET
LAGRAMMAIRE !

• Dans l'article veuillez nous faire savoir l'em-
placement souhaité pour une image spéci-
fique en indiquant le nom de l'image dans un
nouveau paragraphe ou en l'intégrant dans le
document ODT (OpenOffice/LibreOffice).

• Les images doivent être en format JPG, de
800 pixels de large au maximum et d'un niveau
de compression réduit.

• Ne pas utiliser des tableaux ou toute sorte
de formatage en gras ou italique.

Lorsque vous êtes prêt à présenter
l'article, envoyez-le par courriel à :

articles@fullcirclemagazine.org.

Si vous écrivez une critique, veuillez

suivreceslignesdirectrices :

Traductions
Si vous aimeriez traduire le Full Circle

dans votre langue maternelle, veuillez en-
voyer un courriel à ronnie@fullcirclema-
gazine.org et soit nous vous mettrons en
contact avec une équipe existante, soit
nous pourrons vous donner accès au texte
brut que vous pourrez traduire. Lorsque
vous aurez terminé un PDF, vous pourrez
télécharger votre fichier vers le site prin-
cipal du Full Circle.

Auteurs francophones
Si votre langue maternelle n'est pas l'an-
glais, mais le français, ne vous inquiétez
pas. Bien que les articles soient encore
trop longs et difficiles pour nous, l'équipe
de traduction du FCM-fr vous propose de
traduire vos « Questions » ou « Courriers »
de la langue de Molière à celle de Shake-
speare et de vous les renvoyer. Libre à vous
de la/les faire parvenir à l'adresse mail ad
hoc du Full Circle en « v.o. ». Si l' idée de
participer à cette nouvelle expérience vous
tente, envoyez votre question ou votre
courriel à :

webmaster@fullcirclemag.fr

Écrire pour le FCM français
Si vous souhaitez contribuer au FCM, mais

que vous ne pouvez pas écrire en anglais,
faites-nous parvenir vos articles, ils seront
publiés en français dans l’édition française du
FCM.

CRITIQUES

Jeux/Applications
Si vous faites une critique de jeux ou d'applications, veuillez
noter de façon claire :

••le titre du jeu ;
••qui l'a créé ;
••s' il est en téléchargement gratuit ou payant ;
••où l'obtenir (donner l'URL du téléchargement ou du site) ;
••s' il est natif sous Linux ou s'il utilise Wine ;
••une note sur cinq ;
••un résumé avec les bons et les mauvais points.

Matériel
Si vous faites une critique du matériel veuillez noter de façon claire :

••constructeur et modèle ;
••dans quelle catégorie vous le mettriez ;
••les quelques problèmes techniques éventuels que vous auriez ren-
contrés à l'utilisation ;
••s' il est facile de le faire fonctionner sous Linux ;
••si des pilotes Windows ont été nécessaires ;
••une note sur cinq ;
••un résumé avec les bons et les mauvais points.

Pas besoin d'être un expert pour écrire un
article ; écrivez au sujet des jeux, des
applications et du matériel que vous utilisez
tous les jours.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
mailto:webmaster@fullcirclemag.fr
mailto:ronnie@fullcirclemagazine.org
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LLAABBOO LLIINNUUXX
Écrit par Charles McColm

CCoonnssttrruu ii rree uunnee iimmpprriimmaannttee 33DD

R ick Jenkins est bénévole à l'atelier
du Computer Recycling Project

(projet de recyclage des ordinateurs).
Tout en étant un bon technicien, il a
aussi de réelles capacités artistiques,
de modeleur 3D et de bricoleur en tout
genre.

La passion de Rick pour le brico-
lage l'a conduit par le passé à créer une
quantité d'accessoires de Cosplay, de
la veste longue steampunk au fusil
steampunk qui comporte un effet
«  light-by-light » à la mise sous tension
et de forts effets sonores. En outre,
utilisateur Open Source de longue date,
il a démarré avec une des premières
versions de Red Hat Linux. Actuelle-
ment, Rick utilise ArchLinux sur son
ordinateur domestique, mais il a choisi
d'installer Ubuntu sur l'ordinateur de
son dernier projet : l'imprimante Vaster

Mini3 3D mise en valeur sur Instruc-
tables.com :
http://www.instructables.com/id/Buil
ding-a-3D-Printer-Under-299/

L'utilisation d'Ubuntu pour piloter
une imprimante 3D était logique, car
il y a déjà des paquets pour le logiciel
makerbot. Rick utilise Slic3r, qui fait la
même chose que le logiciel makerbot,
etBlenderpourconstruire lesmodèles.

Les imprimantes 3D sont disponibles
depuis quelques années déjà et Rick
prédit que, dans les 5 ans, il existera

des modèles suffisamment bon marché
pour que chacun ait au moins une
imprimante 3D chez lui. Une partie de
l'impulsion pour construire (plutôt que
d'acheter) l'imprimante 3D vient de la
disponibilité des ressources locales. À
Kitchener, dans l'Ontario, le groupe
industriel local, Kwartzlab, a un gros
outil de découpe au laser et plusieurs
imprimantes 3D. L'envie de construire
l'imprimante (plutôt que de l'acheter)
vient de la nature bricoleuse de Rick.

La conception de l'imprimante vient
de instructables.com qui a des liens vers

quelques-unes des sources du châssis,
des moteurs et de l'Arduino. Les vis et
écrous ont été achetés chez Spaenaur
et les tiges métalliques et certains des
composants complémentaires ont été
récupérés sur de vieilles imprimantes
à jet d'encre chez Computer Recycling
Project.

La plus grande difficulté dans la
construction d'une imprimante 3D est
de rassembler toute l'information pour
la construire. La recherche initiale avant
la découpe de la première pièce au
laser a été longue. Savoir pourquoi il
avait besoin d'utiliser chaque pièce était
important pour assurer un fonctionne-
ment correct : s'assurer que les moteurs
pas-à-pas se déplacent de la bonne
distance, s'assurer qu'il n'y a pas de
glissement d'impression (au lieu d'avoir
un cube, obtenir un parallélogramme,
un défaut d'alignement).

Rick a choisi de construire la Vaster
Mini3 plutôt que d'utiliser d'autres plans
de chez Instructable en partie pour
son aspect et en partie parce qu'elle
était annoncée comme une impri-
mante 3D à faire soi-même pour moins
de 300 $. En fait, le coût réel s'est
établi à environ 1 40 $. Les pièces les

http://www.instructables.com/id/Building-a-3D-Printer-Under-299/
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LABO LINUX
plus chères sont le kit de pilotage Ar-
duino et les moteurs Nema 1 7. Rick a
démonté plusieurs moteurs d'impri-
mantes à jet d'encre, mais l'emplace-
ment des trous de montage sur les
plans rendaient les moteurs Nema 1 7
indispensables.

La structure de l'imprimante 3D a
été plus ou moins terminée au bout
d'un mois et demi de travail. Une partie
de ce délai est due à l'accès limité à
l'outil de découpe laser, l'approvision-
nement dans les boutiques du coin et
l'attente de l'arrivée des composants.
Actuellement, il n'attend plus que l'arri-
vée des moteurs. Une fois toutes les
pièces sous la main, il faudra en prin-
cipe seulement deux jours pour le
montage initial complet, les premiers
tests d'impression et la calibration.

La structure étant montée, une
bonne partie de l'imprimante 3D est
construite, mais il y a encore plusieurs
choses qui peuvent aller de travers.
L'Arduino peut ne pas stocker propre-
ment le flashage initial de son BIOS
pour lui dire que c'est une imprimante
3D. Le logiciel Slic3r peut fournir un
code standard gcode que l'Arduino
peut ne pas interpréter correctement.
Un des moteurs Nema 1 7 peut être
en défaut. Le bloc d'extrusion peut se
boucher ou dysfonctionner. L'alimenta-
tion du moteur peut fournir une

vitesse erronée par rapport à la tem-
pérature de la tête. La thermistance
peut mal interpréter la température.
C'est la raison de la longue recherche
initiale de Rick.

Côté informatique, Rick a com-
mencé avec un vieux Pentium 4, mais
il a trouvé que Blender ramait trop.
Computer Recycling Project a eu ré-
cemment plusieurs généreux donateurs
et il a fini par réclamer un système
APU AMD Quad Core A6-3620 avec 8
Go de RAM, un disque dur de 1 To et
une carte graphique Radeon HD6530D.
Cette machine gère n'importe quel
dessin Blender que Rick charge.

Pour quelqu'un qui penserait à cons-
truire une imprimante 3D, Rick sug-

gère de se connecter à une source
d'information, tel qu'un groupe sur
les imprimantes 3D, de façon à pouvoir
échanger avec d'autres personnes qui
ont fait soit l'achat, soit la construc-
tion, d'une imprimante 3D. C'est la
meilleure ressource. Les ressources en
ligne sont super, mais elles ne vous
disent pas toujours tout. Par le contact
direct, vous avez une réponse immé-
diate. En ligne, vous pouvez perdre
beaucoup de temps en essayant de
trouver la bonne réponse. Pendant un
contact direct, si vous avez la machine
sous la main, quelqu'un qui en a cons-
truit une peut la regarder et vous
montrer ce qui ne va pas.

Rick prévoit d'imprimer des pièces
de remplacement pour des ordinateurs

et portables ainsi que pour des pro-
jets personnels spéciaux, comme un
sabre laser ou d'autres accessoires de
costume.

Vous pouvez contacter Rick sur
Googleplus : gaelfling@gmail.com

Kwartzlab : http://www.kwartzlab.ca/
Imprimante VasterMini3 :
http://www.instructables.com/id/Buil
ding-a-3D-Printer-Under-299/
Imprimante Ewaste $60 :
http://www.instructables.com/id/eW
aste-60-3DPrinter/step2/Step-2-
Preparing-Motors/
Slic3r : http://slic3r.org/
Blender : http://www.blender.org/

Charles est l'auteur d'Instant XBMC, un
petit livre sur l'installation et la confi-
guration de XBMCbuntu, une distribution
*buntu + XBMC. Il est le gestionnaire
d'un projet non-lucratif de réutilisation
d'ordinateurs. Quand il ne fabrique pas
des PC, il supprime les logiciels malveil-
lants, en encourageant les gens à utiliser
Linux et en accueillant des « heures
Ubuntu » près de chez lui. Son blog est
à : charlesmccolm.com.

http://www.charlesmccolm.com
mailto:gaelfling@gmail.com
http://www.kwartzlab.ca/
http://www.instructables.com/id/Building-a-3D-Printer-Under-299/
http://www.instructables.com/id/eWaste-60-3DPrinter/step2/Step-2-Preparing-Motors/
http://slic3r.org/
http://www.blender.org/
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TTÉÉLLÉÉPPHHOONNEESS UUBBUUNNTTUU
Écrit par Ronnie Tucker

LE TÉLÉPHONE BQ AQUARIS

DISPONIBLE EN RUSSIE

Après les précédents succès des
lancements des Aquaris E4.5 et

E5 HD Ubuntu Editions, BQ rend main-
tenant disponibles les téléphones Ubun-
tu en Russie. Ces appareils seront pro-
posés à la vente par l'intermédiaire de
nombreux distributeurs locaux comme
Ozon.ru (http://www.ozon.ru/context/de-
tail/id/34629381 /). L'Aquaris E5 HD
Ubuntu Edition sera vendu au prix de

1 5 499 roubles suivi du lancement
prochain de l'Aquaris E4.5 au prix de
1 2 499 roubles.

La Russie continue d'être un marché
important pour Ubuntu avec une base
de fans et une communauté de déve-
loppeurs forte et passionnée. En outre,
la demande augmente dans la région
depuis le lancement initial des appa-
reils en février dernier.

Pour en savoir plus :
https://insights.ubuntu.com/201 5/1 1
/1 7/bq-aquaris-ubuntu-edition-
phones-land-in-russia/

OTA-8

Cette liste comporte seulement
les points importants des quelques
changements disponibles dans cette
mise à jour. Merci de vérifier les détails
de tous les changements compris dans
cette OTA.

CARACTÉRISTIQUES IMPORTANTES

••Nouveau framework 1 5.04.2, UITK
offrant le nouveau composant Page-
Header.

••Nouveau scope Twitter, nouveau scope
agrégateur de livres.
••Contrôles du son dans l'indicateur
audio (Play, Pause).
••Achats dans les applis basés sur QtPur-
chasing.

NAVIGATEUR INTERNET :

••Permissions d'accès des médias pour
les sites.
••Vue des signets principaux.
• Miniatures et vue en grille pour la
page des sites principaux.
••Utilisation de Buteo pour la synchro-
nisation des contacts.
••Rapidité et information d'en-tête pour
le service de localisation.
••Numéro de version OTA maintenant
visible dans les paramètres système
(par ex. OTA-8).
••Appli météo complètement refaite.
••Portage des applis centrales vers
UITK 1 .3.

RÉSOLUTIONS DE PROBLÈMES

Comme nous le savons, chaque mise
à jour contient un très grand nombre
de défauts venant, pour certains, des
versions précédentes, pour d'autres,
de problèmes introduits lors de la

précédente mise à jour. Pour voir la
liste complète des problèmes résolus,
consultez les changements détaillés
plus bas. Les corrections intéres-
santes sont les suivantes :
••Manque de performance de compo-
sants divers résolu (par ex. l'appli de
messagerie, les composants SDK).
••Précision de la localisation résolue.
••Diminution de la consommation de
l'alimentation quand il n'y a pas de
connexion réseau.
••Sonnerie d'appel du téléphone sur
les haut-parleurs quand les écouteurs
sont branchés.
••Solution pour réduire certains blo-
cages de l'interface utilisateur dus au
trafic dbus.
••…et beaucoup, beaucoup d'autres.

DÉTAILS DES CHANGEMENTS

Commitlog (liste des validations) :
http://people.canonical.com/~lzemcz
ak/landing-team/ota/ota-
8.commitlog

Liste d'étape des défauts :
https://launchpad.net/canonical-
devices-system-
image/+milestone/ww46-201 5

https://insights.ubuntu.com/2015/11/17/bq-aquaris-ubuntu-edition-phones-land-in-russia/
http://people.canonical.com/~lzemczak/landing-team/ota/ota-8.commitlog
https://launchpad.net/canonical-devices-system-image/+milestone/ww46-2015
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CCRRIITTIIQQUUEE LLIITTTTÉÉRRAAIIRREE
Écrit par Lucas Westermann

TThhee BBooookkooffGGNNSS33

Juillet 201 5, 272 p.
ISBN : 978-1 -59327-554-9
https://www.nostarch.com/gns3

R écemment, pour en faire la cri-
tique, j'ai reçu une copie de The

Book of GNS3 (le Livre de GNS3) de
Jason C. Neumann chez No Starch
Press. Après l'avoir lu et en avoir testé
le plus possible le contenu, je suis
prêt à exposer ma critique. Mais, avant
que nous passions au livre lui-même,
répondons à une question que cer-
tains lecteurs se poseront sans doute.

QU'EST-CE QUE GNS3 ?

GNS3 veut dire Graphical Network
Simulor-3 (Simulateur graphique de
réseaux, version 3) qui est un outil de
simulation de réseaux (y compris du
matériel virtuel et physique). Il est en
général utilisé pour tester les réseaux
avant déploiement, ou pour des exa-
mens de certification.

A PROPOS DU LIVRE

Le livre examine en détail les maté-
riels/logiciels que le programme peut
gérer, aussi bien que la raison pour
laquelle vous pourriez vouloir l'utili-
ser. Il est destiné principalement aux
ingénieurs réseaux ou aux étudiants
se formant aux réseaux d'une façon
ou d'une autre. Cependant, si vous vou-
lez l'essayer ou si vous voulez étudier
GNS3 pour un travail personnel, ce livre
répondra sans doute à vos besoins.
Alors qu'il propose un index correct,
j'ai du mal à le voir dans un rôle de
livre de référence facile à utiliser.
Aussi, si vous vous ne voulez pas tout
suivre pas à pas, ou si vous cherchez
un livre de « recettes de cuisine », vous
pourriez regarder des équivalents.
Toutefois - ce n'est pas une critique

négative -, il ne se présente pas comme
un livre de recettes, mais comme un
guide pour GNS3. Ce qu'il est réelle-
ment.

STYLE

Jason C. Neumann s'arrange pour
écrire de telle façon que, bien qu'il
fourmille d'informations, la compréhen-
sion en reste aisée, et le livre est
souvent drôle. Il contient aussi un
grand nombre de copies d'écran, ce
qui aide le lecteur à suivre les étapes
avec précision. Elles sont souvent pla-
cées de telle sorte qu'aucun para-
graphe n'est coupé par l'image, ce qui
aide à suivre le texte. Si vous sentez
que vous n'avez pas besoin des
images, les sauter est une chose bien
simple, sans saut de ligne brutal au
milieu d'un paragraphe ou d'une phrase.

Le format choisi pour les com-
mandes et pour le texte assure une
lecture facile, et tous les signes peuvent
être identifiés sans problème. De plus,
les modifications de fichiers, ou les
parties importantes, sont en gras. Avec
les captures d'écran, le formatage est
souvent suffisant pour éviter ou ré-
soudre tout problème rencontré. Non

seulement ça, mais l'auteur reste fidèle
à son formatage dans la partie tex-
tuelle du livre aussi. Cela signifie que
tous les boutons, tous les éléments
de menu ou les autres mots impor-
tants sont également marqués en gras.
Ainsi, si vous parcourez une page en
essayant de trouver où vous vous
êtes trompés, ou bien où cet élément
de menu est passé, vous serez ca-
pable de le retrouver facilement dans
la page.

INFORMATION

Le livre ne prêche pour aucun OS,
il couvre l'installation de GNS3 sous
Ubuntu, Windows et Mac OS X, ainsi
que la compilation depuis les sources.
S'il y a des différences, il traite chaque
système d'exploitation et, parce que
des parties étendues du livre se fo-
calisent sur le matériel virtuel, vous
n'avez pas l'impression de sauter para-
graphe après paragraphe si vous uti-
lisez Linux plutôt que Windows.

Le livre couvre tout, de l'instal-
lation et du paramétrage de GNS3, au
matériel physique ou virtuel, et aussi
quelques projets « pour les jours de
pluie ». L'auteur se focalise principa-

https://www.nostarch.com/gns3
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CRITIQUE LITTÉRAIRE
lement sur les matériels Cisco et
Juniper, mais, parce qu'ils semblent
être le choix le plus courant, c'est une
bonne décision.

CONCLUSION

Bien que ce livre ne soit pas du
tout une liste exhaustive de tout ce
que peut faire GNS3, c'est une ex-
cellente introduction ou un livre d'appui
pour toute personne préparant un
examen de certification ou suivant un
cours où les matériels Cisco et Juni-
per sont privilégiés. Si vous recher-
chez un livre de recettes ou un guide
de référence pour des réponses ra-
pides et faciles aux questions, vous
aurez besoin très probablement de
continuer vos recherches (bien que je
vous recommande de garder celui-ci
dans la liste, au cas où).

Si vous essayez d'élargir votre
horizon par vous-même (pour le tra-
vail ou pour vous), ce livre devrait
pouvoir vous guider dans GNS3 et
vous donne assez d'informations pour
le faire. Cependant, vous devrez faire
quelques recherches sur Google, ou
réaliser vos propres essais de GNS3,
suivant le niveau actuel de vos con-
naissances et votre objectif final. Je
devrais préciser aussi que ce n'est pas
un guide d'étude pour la certification
aux réseaux Cisco ; simplement, ce

livre couvre certains aspects qui peu-
vent apparaître à l'examen. Aussi, si
une certification est votre objectif,
vous aurez besoin d'associer ce livre
avec les autres aspects de votre exa-
men spécifique.

Ce livre n'est pas une ressource
exhaustive, il ne répond pas à tous les
besoins, mais il réalise parfaitement
ce pourquoi il a été conçu : un guide
d'introduction à GNS3.

Lucas a appris tout ce qu'il sait en
endommageant régulièrement son sys-
tème, et en n'ayant alors plus d'autre
choix que de trouver un moyen de le
réparer. Vous pouvez lui écrire à :
lswest34@gmail.com.

mailto:lswest34@gmail.com
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MMOONN HH II SSTTOOIIRREE
Écrit par AuntieE

P uisque Ronnie nous avait fait part
de la récupération de plus de

500 photos avec Photorec après
l'Affreux Plantage de son disque dur
en 201 4, j'ai proposé à une amie amé-
ricaine d'essayer de récupérer des
photos sur son disque dur à elle. L'in-
formaticien du coin lui avait dit que le
disque était tellement abîmé qu'il
serait impossible d'en tirer quoi que
ce soit… et, pourtant, le disque conte-
nait des photos personnelles impor-
tantes. Mon amie m'a donc envoyé le
disque par la poste et, après son
passage au frigo (PAS au congélateur !)
pendant toute une nuit, j'ai com-
mencé le travail.

Windows 1 0, sur un portable To-
shiba de 4 ans, suggérait sans cesse
de formater les deux partitions (l'une
étant Windows RE-Store, l'autre, appa-
remment, le système et les données,
dans une configuration d'environ 1 0 %
pour le Re-Store et 90 % pour le
reste), mais, après une longue période
de réflexion, disait que le formatage
était impossible. L'utilitaire disque de
Lubuntu 1 4.04 (sur un Netbook Sam-
sung qui date de 2008) ne reconnais-
sait même pas le disque. Après avoir
cherché testdisk sur Google, je suis

allée sur la page officielle de téléchar-
gements à http://www.cgsecurity.org/wi-
ki/TestDisk_Download où la dernière
version est la 7.0. J'ai téléchargé le
fichier testdisk-7.0.linux26.tar.bz2 que
j'ai copié dans mon dossier personnel
sur le Samsung. Ensuite, suivant les
instructions du site, j'ai ouvert un ter-
minal et l'ai décompressé avec la com-
mande :

sudo tar xvf
testdisk-7.0.linux26.tar.bz2

Ainsi fut créé un dossier nommé
testdisk-7.0, à l'intérieur duquel, parmi

d'autres fichiers, se trouvaient tes-
tdisk_static et photorec_static.

Bon. Je pensais commencer avec
le testdisk_static et, après un certain
temps, les deux partitions furent
surlignées en vert, bien que le disque
ne soit toujours pas reconnu par l'uti-
litaire de disque. (Je vous avoue que
je ne suis pas allée voir dans le journal
testdisk et je n'ai pas essayé d'y com-
prendre quoi que ce soit…) Au lieu de
cela, j'ai pris photorec sans attendre
davantage. Tout se fait en ligne de
commande :

cd testdisk-7.0

puis :

sudo ./photorec_static

Une page s'est affichée, me de-
mandant d'identifier le disque dont je
voulais récupérer le contenu, /dev/sda/,
le disque du Netbook, ou /dev/sdb/,
le disque de mon amie (dans un boî-
tier externe branché sur USB). Quant
à la partition, au départ, j'ai choisi
celle de Windows, mais, après environ
six heures, j'ai tout arrêté et recom-
mencé au début.

Je ne vais pas vous ennuyer avec
les milliers d'essais que j'ai faits ; ils
duraient toute la nuit et au-delà, (jus-
qu'à ce que tout soit trop chaud pour
fonctionner). Après quelques jours,
cependant, je me suis enfin rendue
compte qu'il y avait des options que
je pouvais utiliser (c'est mon cerf-
volant !)… Mieux vaut tard que jamais.

Ainsi :

cd testdisk-7.0,

sudo ./photorec_static

mot de passe pour root sur Lubuntu,
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MON HISTOIRE
nouvelle page, sélectionner disque,
nouvelle page, sélectionner partition,
nouvelle page, type de partition sélec-
tionnée (dans ce cas FAT, etc.), nou-
velle page, Où voulez-vous enregis-
trer les fichiers récupérés ? Photorec
suggère de les sauvegarder à l'inté-
rieur du dossier testdisk-7.0 et j'ai
donc appuyé sur « c » pour « correct »,
indiquant que cela me convenait.

À un moment quelconque, en bas
d'une de ces pages, là où la première
option (« Proceed ») est sélectionnée
par défaut, vous avez la possibilité de
choisir « Options » (touche fléchée
droite + Entrée) et, là, de NE PAS
désactiver Brute Force (autrement dit,
de l'activer) en décochant Do not
disable Brute Force, puis Entrée. En-
suite, avec la touche fléchée, vous
pouvez aller dans « File Opt » options
des fichiers) où vous pouvez tout
désélectionner en appuyant sur « b »
(je pense - je fais cette partie-ci de
mémoire car le Netbook refuse de
faire quoi que ce soit d'autre avec le
disque dur)… Tous les « X » dans les
cases à gauche des types de fichiers
disparaissent alors et vous pouvez
descendre la liste pour choisir ce dont
vous avez besoin, dans mon cas, JPG
et DOC. Puis Entrée. Après, vous pou-
vez revenir à Proceed (avec la touche
fléchée gauche) et appuyer sur Entrée.

Avec seulement deux types de
fichiers sélectionnés, la recherche se
faisait nettement plus rapidement :
cela ne prenait plus maintenant que
465 heures (au lieu de 1 654 ou quel-
que chose du genre, incroyable). Si, à
un moment quelconque, vous voulez
arrêter la recherche, il suffit d'ap-
puyer sur Entrée, parce que STOP est
déjà surligné. Après, c'est le scénario
familier de « Do you really want to
Stop » (Voulez-vous vraiment tout arrê-
ter ?), etc. Et, une excellente surprise
vous attend : la prochaine fois que
vous utiliserez Photorec, il vous deman-
dera si vous voulez reprendre la der-

nière recherche. Y (pour « yes », oui) +
Entrée (si c'est le cas). Sélectionnez
l'emplacement du stockage des fichiers
récupérés (« c » pour correct), et ça
reprend…

Que récupérez-vous en réalité ? Si
vous commencez en incluant tous les
types de fichiers, vous allez vous
retrouver avec environ 50 Go de trucs
dans plusieurs dossiers différents nom-
més recup_dir1 , recup_dir2 jusqu'à
recup_dir34 et ainsi de suite, selon le
nombre de vos essais. La plupart des
fichiers .doc que j'ai récupérés étaient
des fichiers système (dont l'un faisait

à lui tout seul 480 Mo - c'était tota-
lement impossible de l'ouvrir avec
LibreOffice), il y avait plusieurs .db
qui, me suis-je dit, pouvaient être des
tables de généalogie, mais, quand j'ai
essayé de les ouvrir à la fois sous Linux
et sous Windows, j'ai eu un message
disant que c'étaient des fichiers sys-
tème. Malheureusement, la moitié, au
moins, des fichiers .jpg étaient des pho-
tos de publicité, ou de sites de com-
mande en ligne : des tapis, des panta-
lons, des robes, etc., sans intérêt aucun.
MAIS j'ai pu récupérer 1 90 vraies pho-
tos bien qu'il y ait quelques doublons.

Quant aux dossiers recup_dir gigan-
tesques, je n'arrivais pas à trouver
comment les supprimer. Même « sudo
nautilus » ne permettait pas leur sup-
pression. Finalement (grâce à un nu-
méro récent du Full Circle), j'ai essayé
« sudo su » et nautilus et enfin j'ai pu
les effacer et créer un peu de place sur
le disque dur de mon petit Netbook.

Tout compte fait, je pense que les
clés d'une utilisation réussie de Pho-
torec, sont : la persistance, la patience
et la perspicacité. Demain, j'enverrai à
mon amie un CD plein de ses photos
perdues et ça, c'est ce que j'appelle
un triomphe : le triomphe de Lu-
buntu, de Photorec, et du Full Circle.
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CCOOUURRRRIIEERRSS
Si vous voulez nous envoyer une lettre, une plainte ou des compliments,
veuillez les envoyer, en anglais, à : letters@fullcirclemagazine.org.
NOTE : certaines lettres peuvent être modifiées par manque de place.

PERSONAL FINANCES

R e: personal finance applications:
For years, I have always used

Gnucash for all my banking needs. It
allows you to go to your banking and
"download to Quicken" which will
download bank debits/credits to your
Gnucash account. Setup is not
difficult.

You can print reports for assets
and liabilities, budget, business
reports, income expenses and more.

Tom

Ronnie says: Tom haskindlywritten up

a quick intro to Gnucash that will be

featured in a future issue ofFCM. Stay

tuned!

DISTRO HOPPING

I have been using Linux for many
years, starting with Mandrake over

1 5 years ago. Now I use Linux Mint
Cinnamon as my main distro, but have
been trying to find a KDE-based
distro which would give me the same
stability. I have used Arch-based

distros like Manjaro and KaOS,
Debian-based distros, and RPM-based
distros, but they all let me down at
some time or other. Almost in
desperation, I am now using Kubuntu
1 5.1 0, which seems pretty stable and
gives me all the apps that I require,
plus enough customisation to get my
screen looking the way I want it.

It seems that Ubuntu-based
distros are still the best and most
reliable Linux distros.

Bernie Victor

MULTIBOOT WITH UEFI

I read this excellent article by FrankDennisen in FCM#1 02, but would
like to add one word of warning,
based on my own experience.

Frank advises to run fstrim during
boot-up by editing /etc/rc.local. I
normally schedule fstrim with cron to
a time when I know I will not be using
the machine.

I tried Frank's suggestion but

forgot fstrim was running next time I
rebooted. I then tried to suspend and
the computer ignored this for a while
and then went to a black screen. I hit
Enter and the screen repainted and
then suspended ok. When I tried to
wake-up the machine, I got a terminal
with a lot of messages about memory
locations being unusable. A reboot
fixed the problem.

Frank's suggestion will work ok
but I think it is necessary to let fstrim
finish before creating any disk
activity. Unfortunately there is no
indication of when it finishes and it
can take some time; six minutes in my
case.

Michael

Rejoignez-nous sur :

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

LE FULL CIRCLE

A BESOIN DE VOUS !
Sans les contributions des
lecteurs, le Full Circle ne

serait qu'un fichier PDF vide (qui,
à mon avis, n'intéresserait per-
sonne). Nous cherchons toujours
des articles, des critiques, n'im-
porte quoi ! Même de petits trucs
comme des lettres et les écrans
de bureau aident à remplir le ma-
gazine. Lisez Écrire pour le FCM
dans ce numéro pour suivre nos
lignes directrices.

Jetez un œil à la dernière page
(de n'importe quel numéro) pour
accéder aux informations détaillées
concernant l'envoi de vos contri-
butions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
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EENNTTRREETTII EENN AAVVEECC.. .. ..
Dirigé par Ronnie Tucker

eeBBuuyyeerr
FCM : Puis-je me permettre de vous
demander combien de PC et de por-
tables Ubuntu vous avez vendus ?

eBuyer : Je suis désolé, je ne peux
pas vous donner les données de vente
précises, mais nous sommes satisfaits
de l'adoption d'Ubuntu et de ses ventes,
car elles dépassent nos prévisions ini-
tiales.

Ces résultats solides signifient que
nous pouvons anticiper l'année pro-
chaine, en nous ouvrant à plus de fa-
bricants.

Combien (en nombre ou en pour-
centage) ont été retournés ?

À nouveau, je ne peux pas vous four-
nir des données commerciales, mais,
pour 201 5, nos retours sont, de ma-
nière marginale, plus bas sur les por-
tables Ubuntu que sur les équivalents
en Windows 8.

Fournissez-vous un support pour les
machines Ubuntu ou est-ce que vous
dirigez vos acheteurs ailleurs pour
de l'aide ?

Les fabricants (HP pour la gamme ac-
tuelle de portables) couvrent les pro-
blèmes principaux d'assistance ; cepen-
dant, notre propre équipe technique

de support a été formée pour aider
sur un large éventail de problèmes clas-
siques spécifiques à Linux.

Envisageriez-vous la vente de télé-
phones Ubuntu (de HQ/Meizu) ?

Nous avons regardé les possibilités
d'importer un téléphone Ubuntu au
Royaume-Uni ; nous avons juste besoin
de trouver le bon distributeur et la
bonne structure de prix.

Un certain nombre de nos clients
ont montré beaucoup d’intérêt pour
le modèle de BQ ; aussi, on avance sur
le bon prix et le bon partenaire…
surveillez cette section.

Expédiez-vous des commandes aux
États-Unis/Canada ou en dehors du

Royaume-Uni et de l'Europe ?

Malheureusement, pas pour le moment,
nous ne livrons qu'au Royaume-Uni.

J'ai remarqué que la plupart des PC
de bureau sont livrés avec un DVD.
Puis-je savoir pourquoi Ubuntu n'est
pas pré-installé ?

Ubuntu est pré-installé sur les por-
tables que nous stockons. Cependant,
du fait des fabricants que nous uti-
lisons actuellement pour les ordina-
teurs de bureau, ils arrivent avec une
installation par DVD. Le prochain lot
que nous stockerons arrivera probable-
ment avec une pré-installation stan-
dard.

Pourquoi Ubuntu 12.04 est-il ins-
tallé sur certaines machines (des
portables ?) ?

Ubuntu 1 2.04 était simplement l'OS
standard sur le lot de portables HP G3
que nous avions rentré. Cependant, la
plupart des gens font une montée de
version vers la dernière édition d'Ubun-
tu ou parfois changent pour une autre
distribution comme Mint.

Qu'est-ce qui vous a donné l'idée
d'utiliser Ubuntu ?

Nous avions l'habitude de vendre beau-
coup de produits sans système d'ex-
ploitation installé ; aussi, nous en avons
cherché les raisons et avons trouvé
qu'il y avait une forte communauté
pour les systèmes Linux, particuliè-
rement Ubuntu. De là, nous avons
voulu rendre les choses plus simples
pour les clients et nous avons créé
une gamme de modèles pré-installés
qui, nous l'espérions, décollerait, et
c'est arrivé, parce qu'il n'y a quasi-
ment pas de revendeurs du Royaume-
Uni qui offrent Ubuntu pré-installé.

Avez-vous une saveur favorite
d'Ubuntu ?

Personnellement, je préfère le paquet
Ubuntu standard, car il semble plus

http://www.ebuyer.com/ubuntu
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ENTRETIEN AVEC EBUYER
proche d'un OS traditionnel, mais, avec
la liberté offerte par Linux, je suis un
petit nouveau dans le monde Linux et
ça aide d'avoir quelque chose de
proche de mes vieilles habitudes d'OS.

Du point de vue de nos clients,
nous avons vraiment eu beaucoup de
commentaires et de questions à pro-
pos de Lubuntu du fait de sa légèreté
et sa vitesse. Je serais tenté de dire
que Lubuntu s'en tirera bien l'année
prochaine.

D'où viennent la plupart de vos
clients Ubuntu ?

Une grande proportion sont des
acheteurs de l'informatique, comme
vous pouvez le penser, ainsi qu'une
quantité de convaincus. À côté de ça,
et peut-être plus surprenant, beau-
coup de personnes âgées regardent
vers Ubuntu ; nous pensons que c'est
à cause de son coût et de la nature
conviviale de l'OS.

Devez-vous apporter plus, ou moins,
d'assistance auxacheteurs d'Ubuntu ?

C'est difficile à gérer en termes d'as-
sistance parce qu'actuellement la base
de clients est encore petite (en com-
paraison). Si, comme nous l'espérons,
les ventes d'Ubuntu s'améliorent sur
plusieurs lignes, nous serons ravis d'aug-
menter l'assistance.

Avez-vous eu des difficultés de maté-
riel en assemblant des PC/portables
Ubuntu ?

Comme vous pouvez l'imaginer, cer-
tains fabricants ont des liens très
étroits avec Microsoft ; aussi, c'est
parfois compliqué d'obtenir une pré-
installation d'Ubuntu. Cependant, les
sociétés avec lesquelles nous avons
discuté pour des accords futurs ont
été très ouvertes au vu de la péné-
tration actuelle.

Envisagez-vous de proposer des ma-
chines plus puissantes sous Ubuntu ?
Ou feriez-vous, disons, une gamme
de machines Lubuntu/Xubuntu ?

Le prochain lot de machines sous
Ubuntu sera probablement de la pro-
chaine génération ; donc, oui, elles se-
ront plus puissantes.

Le principal retour sur notre pre-
mier stock d'Ubuntu (en 201 4) était
«  super de voir Ubuntu, mais nous avons
besoin d'un portable plus puissant ».
En 201 5, nous avons donc proposé un
processeur plus agressif et plus de
RAM. Nous allons probablement es-
sayer de faire le même saut cette
année, cela dépend simplement du
fabricant qui fournira les unités.

Je ne pense pas qu'on change pour
Lubuntu/Xubuntu tout de suite ; Ubuntu
a encore beaucoup de chemin à faire
pour arriver à une popularité dispo-
sant d'une plus grande écoute.

Et à propos de personnalisation avec
Ubuntu ?

Nous n'étudions pas vraiment la
réalisation d'une modification personna-
lisée d'une quelconque des machines ;
c'est peu probable que nous le fas-
sions pour Ubuntu.

Utilisez-vous Ubuntu/Linux dans les
bureaux d'eBuyer ?

Nous avons un large éventail d'OS, ici,
dans les bureaux. Notre équipe de
développement informatique est le
plus gros consommateur. Comme vous
pouvez l'imaginer, il y a une variété de
distrib. Linux, les plus populaires étant
Mint, Ubuntu et Debian. Le marketing
a aussi deux machines Ubuntu, mais
le reste de l'entreprise est à base de
Windows.

eBuyer : http://www.ebuyer.com

http://www.ebuyer.com/ubuntu
http://www.ebuyer.com/ubuntu
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QQ.. EETT RR..
Compilé par Gord Campbell

Si vous avez des questions sur Ubuntu, envoyez-les en anglais à :
questions@fullcirclemagazine.org, et Gord y répondra dans un prochain numéro.
Donnez le maximum de détails sur votre problème.

Q Je suis en train d'installer Ubuntu,
mais l'ensemble de mon disque

dur est rempli de partitions. Est-il pos-
sible de connaître les partitions qui
peuvent être supprimées sans risque ?
J'ai inclus une capture d'écran des
partitions (ci-dessus).

R (Merci à SeijiSenseisur les forums
Ubuntu.) Plutôt que de supprimer

des partitions, j'utiliserais le gestion-
naire de disques de Windows (Pan-
neau de configuration > Gestion de
l'ordinateur > Gestion des disques)
pour réduire la partition Windows puis
donner l'espace libéré à Linux lors de
l'installation.

Q J'ai très, très envie d'installer Tails
mais je tiens à garder ma confi-

guration actuelle en double amorçage
Ubuntu 1 5.1 0 + Windows 1 0. Est-il pos-
sible de tripler l'amorçage avec Tails ?

R (Merci à DK1993 et Bucky Ball
sur les forums Ubuntu.) Tails est

censé être utilisé dans un environne-
ment « live ». Il est censé fonctionner
en mémoire vive et supprimer toutes
les informations lorsque l'ordinateur
s'éteint. Sinon, étant donné les distri-
butions qui sont destinées à une ins-
tallation sur un disque dur, oui, vous
pouvez triple-amorcer sans problème.
Vous avez juste besoin d'espace libre

sur le disque pour créer une partition
et installer dessus.

Q Pendant le démarrage, j'ai reçu
ce message d'erreur :

USB 2/3 device descriptor
read64, error -110

Ça s'est répété encore deux fois,
puis j'ai eu d'autres messages d'erreur.

R Cela parait dingue, mais ceci fonc-
tionne : éteignez votre ordinateur,

débranchez-le pendant cinq minutes,
puis rebranchez-le et démarrez-le.

Q Mon serveur vortexbox est inac-
cessible. Son adresse IP est

1 92.1 68.1 .255

R (Merci à SeijiSenseisur les forums
Ubuntu.) 1 92.168.1 .255 est l'adresse

de « broadcast » pour le réseau
1 92.1 68.1 .0/24. Les deux adresses
1 92.1 68.1 .0 et 1 92.1 68.1 .255 ne
peuvent pas être attribuées à des
hôtes. Donnez une adresse différente
au serveur.

Q Je veux limiter la quantité de
bande passante Internet qu'un

utilisateur quelconque peut avoir.

R (Merci à matt_symes sur les fo-
rums Ubuntu.) Vous pouvez faire

un écrêtage du trafic avec la com-
mande : tc

Je vous conseille de lire la page de
man et de consulter des tutoriels sur
le Net, car c'est un domaine énorme.

TOP DES QUESTIONS SUR

ASKUBUNTU

* Quelle est l'importance du mot de
passe de sudo ?
http://goo.gl/8NxLe6

* Comment créer un fichier .iso dé-
marrable à partir d'un Unbuntu Live
sur clé USB ?
http://goo.gl/FRsgmu

* Détruire en ligne de commande tous
les fichiers sauf des fichiers et dos-
siers précis.
http://goo.gl/S1 LCVG

mailto:questions@fullcirclemagazine.org
http://goo.gl/8NxLe6
http://goo.gl/FRsgmu
http://goo.gl/S1LCVG
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Q. ET R.
* Récupérer tous les fichiers images
avec wget.
http://goo.gl/OVLx4n

* Réinstaller une version de base
d'Ubuntu sans reformater ni enlever
de paquets manuellement installés.
http://goo.gl/RSQWrb

* Est-ce que la version serveur
d'Ubuntu 1 6.04 LTS utilisera toujours
dpkg ?
http://goo.gl/mON1 J4

* Est-ce que Linux devient moins ou
plus sécurisé ?
http://goo.gl/EOAUc6

* La 1 5.04 est disponible pour une
mise à jour. Est-ce que je vais perdre
mes données ?
http://goo.gl/8Iz4w2

* Aucune version d'Ubuntu ne peut
être installée sur un processeur Intel
de 6e génération.
http://goo.gl/NXEXaR

TRUCS ET ASTUCES

GRAND NETTOYAGE !

C eci a peu à voir avec Linux, mais
j'espère que c'est quand même

intéressant.

Mon ordinateur de bureau « haute
performance » est vieux de plusieurs
années. Ces derniers mois, il sur-
chauffait si on lui demandait de faire
quelques calculs légers. Même lire
une vidéo Youtube était suffisant pour
causer problème.

Je peux dire cela parce que Conky,
combiné avec lm-sensors et hdd-temp,
affiche toutes les températures tout
le temps. L'ordinateur a une partition
« production » et une partition « test »,
qui ont chacune Conky installé pour
me donner tous les renseignements
dont j'ai besoin.

Finalement, je me suis décidé à
aborder le problème. Ouverture du boî-
tier, retrait du radiateur de CPU et du
ventilateur, et un bon nettoyage des
deux. J'ai aussi remarqué que la « pâte
thermique », qui relie le processeur au
radiateur, était désagrégée. Nouvelle
pâte thermique, ré-installation du ra-
diateur et du ventilateur, fermeture
du boîtier, et tout marche bien.

Ce n'est pas une tâche pour les
peureux ! Si l'idée de vous y mettre
vous rend mal à l'aise, portez votre
ordinateur à un technicien de confiance
et soyez prêt à payer une prestation
raisonnable pour le service. 1 00 €
n'est pas trop. Pourquoi ? Parce qu'occa-
sionnellement, les doigts du presta-
taire de service, même le plus com-
pétent, peuvent glisser, nécessitant
alors de changer les processeur, mé-
moire et carte mère. Pas donnés.

Pour ce qui me concerne, ça a su-
per bien marché. Mon CPU reste à la
même température que moi et, même
en lisant des vidéos, il ne va jamais se
balader vers le « trop chaud ». Comme
avant, j'ai un ordinateur « haute per-
formance ».

Note : sur ma partition de « test »,
j'ai mis à jour Xubuntu 1 5.04 vers la
1 5.1 0, et ça c'est passé sans heurt.
C'est de là que j'écris ces lignes.

Gord eut une longue carrière dans l'in-
dustrie informatique, puis a profité de
sa retraite pendant plusieurs années.
Plus récemment, il s'est retrouvé, sans
savoir comment, « l'informaticien » d'un
petit cabinet d'expertise comptable de
1 5 personnes dans le centre-ville de
Toronto.

http://goo.gl/OVLx4n
http://goo.gl/RSQWrb
http://goo.gl/mON1J4
http://goo.gl/EOAUc6
http://goo.gl/8Iz4w2
http://goo.gl/NXEXaR
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SOL
D OUT

http://www.meizu.com/en/ubuntu/features.html
http://bq.com
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SSééccuurrii ttéé
Écrit par Alan Ward

L es codes QR « Quick Response »
(réaction rapide) sont en passe de

devenir un moyen populaire de com-
muniquer des fragments d'information
depuis un support imprimé ou une
autre surface physique vers des ordi-
nateurs ou des appareils mobiles. Ils
ont été développés au départ par une
équipe de la société Denso Co Ltd,
qui développe et fabrique des équi-
pements automobiles, pour remplacer
le code-barres linéaire. L'augmentation
du nombre des différentes pièces de
voiture manipulées fit naître le désir
d'augmenter en parallèle la quantité
de données pouvant être stockée sur
les étiquettes imprimées utilisées pour
identifier les boîtes dans le stock et
pendant le transport.

Depuis 2006, les principes de fonc-
tionnement sont devenus la norme
ISO/IEC n° 1 8004:2006, et peuvent ainsi
être vus comme une technique indus-
trielle reconnue. L'équipe en charge
de cette conception ((Masahiro Hara,
Motoaki Watabe, Tadao Nojiri, Taka-
yuki Nagaya, and Yuji Uchiyama) gagna
le Prix du public 201 4 de l'Office eu-
ropéen des brevets pour sa démarche
(http://www.epo.org/learning-
events/european-

inventor/finalists/201 4/hara_fr.html).

De nos jours, les codes QR sont
largement utilisés dans des situations
où l'on souhaite disposer d'imprimés
contenant des liens vers de l'informa-
tion électronique, qu'un ordinateur
peut facilement interpréter. Quelques
exemples : la carte des stations du
réseau de bus qui inclut un lien en
code QR vers la page Internet de la
compagnie pour obtenir les dernières
informations sur les horaires, une affiche
pour un festival de musique avec un
lien en code QR relié au service de
billetterie en ligne, ou des billets de
train ou d'avion avec des codes QR
qui sont lus à la porte d'embarque-
ment pour autoriser la montée à bord.

En même temps, les gens de la
conception graphique utilisent le fait
que les données sont en fait redon-
dantes dans le code ; l'image peut
être modifiée de diverses façons, tout
en transmettant des informations utiles
au lecteur. Un récent exemple de
201 4 est la « Coupe QR de Guinness »
par BBDO New-York qui a gagné un
prix Caples (http://www.caples.org/guin-
ness-qr-cup-0). L'idée fait référence à
un verre de bière Guinness avec un

code QR imprimé dessus, qui n'est
lisible que si le verre est rempli de son
liquide noir : seuls les points blancs
sont réellement imprimés, alors que
les points noirs sont dus à la bière elle-
même derrière le verre transparent.

Dans cet article, nous verrons
comment lire et écrire des codes QR
dans un système Ubuntu en utilisant
différents programmes. Avant de
continuer, il est à noter que plusieurs
autres systèmes similaires peuvent
être trouvés, tel que les codes-barres
Data Matrix (https://en.wikipedia.org/wi-
ki/Data_Matrix) et les codes Aztec
(https://en.wikipedia.org/wiki/Aztec_
Code). Bien que chacun de ces codes
ait ses supporters, les codes QR
semblent, actuellement, être les mieux
supportés, à la fois par Ubuntu et par
les applications des appareils mobiles.

ANATOMIE D'UN CODE QR

Voici un exemple précis (haut de
colonne suivante) :

Comme on peut le voir, un code
QR est une matrice bi-dimensionnelle
carrée remplie de points (pixels) qui,
par essence, sont des uns et zéros

binaires. C'est en fait une des seules
fois où un utilisateur moderne d'équi-
pements informatiques aura l'occa-
sion d'approcher d'aussi près du code
binaire, car il est souvent enfoui sous
différentes couches de logiciels.

Quand un lecteur de code QR est
placé devant cette image, les pre-
mières parties détectées sont les trois
marques de positionnement mises en
évidence en doré. Elles donnent à la
caméra une première idée de la posi-
tion du code QR, ainsi que son orien-
tation. Le petit repère en rouge aide
aussi à comprendre l'alignement ; il
n'y en a qu'un sur les petits codes QR,
mais les plus gros codes utilisent un
motif répétitif pour assurer la cohé-
rence dans la largeur et la hauteur de
l'image.

QQRR CCooddeess

http://www.epo.org/learning-events/european-inventor/finalists/2014/hara.html
http://www.epo.org/learning-events/european-inventor/finalists/2014/hara.html
http://www.caples.org/guinness-qr-cup-0
https://en.wikipedia.org/wiki/Data_Matrix
https://en.wikipedia.org/wiki/Aztec_Code
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Les codes QR peuvent exister en

plusieurs largeurs, exprimées en nom-
bre de points utilisés. Cependant, cela
n'a pas de rapport avec la taille réelle
de l'image, ni avec la résolution de la
photo que le lecteur en a prise. Aussi,
la deuxième étape dans l'interpréta-
tion du code est de déterminer com-
bien de points sont utilisés dans ce
code précis. Pour cela, un motif simple
répétitif de points blancs et noirs est
placé entre les marques d'orientation
(visualisées en vert). Le motif « tem-
porel » (appelé « timing ») est facile à
interpréter par le lecteur pour trouver
ainsi le nombre de lignes et de co-
lonnes de la trame.

Le reste des points correspond a
un mélange d'information sur la version
du code QR, information sur le for-
mat, la date réelle et des codes de
correction d'erreurs. La correction d'er-
reur est nécessaire car les appareils
photo ne donnent pas toujours une
image claire de la zone de code (à
cause de présence de poussière, de
défauts sur la lentille…) ; l'interpré-
tation peut aussi produire des points
erronés (si les couleurs ne sont pas
correctement détectées), ainsi que le
flou si l'appareil n'est pas tenu par-
faitement stable à cet instant.

La correction d'erreur des codes
QR utilise un dérivé des codes de

correction d'erreur Reed-Salomon. En
simplifiant un peu (peut-être beau-
coup), ces codes peuvent être essen-
tiellement vus comme une répétition
de toute l'information, faite plus d'une
fois. La redondance est calculée de
manière à ce que non seulement les
erreurs soient détectées, mais aussi
corrigées à la lecture. Avec un nom-
bre suffisant de bits supplémentaires
ajoutés à chaque mot de données,
plus d'une erreur peut être détectée,
contrairement à des mécanismes plus
simples dans lesquels deux erreurs dans
le même mot passent inaperçues.

De nos jours, les détails de com-
ment la détection et la correction
d'erreur sont réalisées passent sous le
radar de l'utilisateur humain. Le logi-
ciel (dans les appareils grand public)
ou le matériel (dans les applications
industrielles) prend en charge cette
partie et nous fournit simplement l'infor-
mation décodée dans un format lisible.

En fait, l'addition de couleurs super-
posées au code QR ci-dessus ne l'a pas
rendu illisible - si vous avez un lecteur
de code QR ou une application dispo-
nible, essayez et regardez ce qu'il dit !

QUELQUES LOGICIELS

Il y a en fait un certain nombre de
logiciels disponibles dans les dépôts

Ubuntu pour créer des codes QR. Un
des plus basiques est qrencode issu
du paquet apt du même nom. C'est
un programme uniquement en ligne
de commande. Par exemple, pour en-
coder l'adresse de la page Internet de
notre magazine favori, tapez simple-
ment :

qrencode -o qr-example1.png
http://fullcirclemagazine.org

Ceci crée l'image qr-example1 .png
dans le répertoire courant : Le même
programme peut aussi créer des codes
QR dans divers formats. SVG est par-
ticulièrement intéressant. La commande
correspondante serait :

qrencode -o qr-example1.svg
-t SVG
http://fullcirclemagazine.org

Dans l'autre sens, le paquet zbar-
tools contient des programmes pour
convertir un code QR lu à partir d'un
appareil photo (zbarcam) ou à partir
d'un fichier image (zbarimg). Par
exemple :

zbarimg qr-example1.png

QR-
Code:http://fullcirclemagazine
.org/ [code QR :
http://fullcirclemagazine.org/]

scanned 1 barcode symbols from
1 images in 0.02 seconds [1
symbole code-barres scanné à
partir d'une image en 0.02
secondes]

Du côté interface graphique, celui
qui est peut-être le plus connu sous
Ubuntu est QtQr. Utilisant la biblio-
thèque Qt sur laquelle le bureau KDE
est basé, ce programme fonctionne
très bien avec les autres gestion-
naires de bureau aussi, étant suffisam-
ment intégré pour inclure le déplace-
ment des fichiers vers et depuis l'ap-
plication.

Le logiciel contient un générateur
complet de code QR, où l'utilisateur
peut non seulement spécifier le type
d'information à encoder (des URL,
mais aussi d'autres informations struc-
turées telles que des informations
individuelles de contact, un géo-réfé-
rencement ou même des détails sur
le réseau WiFi), mais aussi la taille des
points en pixels, la largeur de la marge
et le niveau de redondance des don-
nées à utiliser.

QtQr lit les codes QR soit à partir
de fichiers images, soit en accédant à
la webcam de l'ordinateur si elle est
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disponible. C'est pratique de lire les
données à partir de son téléphone
mobile, sans avoir besoin de para-
métrer une liaison sans fil (Bluetooth
ou similaire).

ÉDITER DES CODES QR

Une fois qu'un code QR a été créé, il
est possible de le modifier sans alté-
rer l'information qu'il contient. Je choisis,
comme exemple, le QR « http://full-
circlemagazine.org » ci-dessus, en for-
mat SVG. Comme c'est un dessin au
trait, il peut être importé dans un pro-
gramme de traitement vectoriel comme
Inkscape et modifié comme nous le
souhaitons. En l'ouvrant dans Inkscape,
la première chose que nous remar-
quons c'est que le fond blanc a été
groupé avec les marques noires. Nous
pouvons sélectionner l'ensemble et

appuyer sur Ctrl-Maj-G pour les dé-
grouper.

Les marques noires elles-mêmes
sont aussi des rectangles individuels
qui ont été regroupés. Si vous souhai-
tez enmodifier des morceaux élémen-
taires, ils doivent d'abord être dégrou-
pés. Dans notre exemple, cependant,
nous allons les garder tous d'une
seule pièce.

La première chose que nous pou-
vons faire, c'est de changer la couleur
des marques noires. Sélectionnez les
marques, puis choisissez Objet >
Remplissage et contour dans le menu.
Nous pouvons jouer avec la couleur
de remplissage et ajouter du flou
pour l'effet artistique.

Les codes QR sont suffisamment
robustes pour que même des cou-
leurs relativement claires puissent être
utilisées, tout en gardant leur rôle de
code. Cependant, il ne faut pas aller
trop loin - « trop loin », ce sont les
couleurs à trop faible contraste sur le
fond ou une combinaison de couleurs
claires et sombres. Celles-ci ne fonc-
tionnent pas bien avec la plupart des
lecteurs de QR. Si nous restons bien
dans de telles limites, des effets sont
possibles, comme les dégradés. Pour
les appliquer, sélectionnez le marquage,
et dans la boîte de dialogue du Rem-
plissage choisissez Dégradé linéaire.
Vous devrez modifier les limites du
dégradé pour assurer que les deux
couleurs utilisées dans le dégradé sont
suffisamment contrastées sur le fond.
Quelques essais pourront être néces-
saires pour de bons résultats.

Dans Inkscape, les photos peuvent
être utilisées comme motifs pour
remplir des zones. L'image (jpg, png
ou équivalent) est importée, puis
convertie en motif en utilisant le
menu Objet > Motif > Objet en motif.
Les marques noires du code QR sont
ensuite sélectionnées et remplies avec
le nouveau motif. Comme précé-
demment, il est préférable d'utiliser
une image contenant des couleurs
voisines et plutôt sombres, sans points
de couleurs claires à l'intérieur (si
vous utilisez un fond blanc).

En revanche, les images très claires
peuvent être utilisées pour colorer le
marquage, sur un fond sombre. Au-
trement, une seule couleur peut être
utilisée pour les marques, que l'on
superpose sur l'image. Tant que le
contraste reste suffisamment élevé
pour que le lecteur de code QR dé-
tecte les marques correctement, à
peu près n'importe quelle combinai-
son peut être essayée.

C'est à peu près tout ce qu'on
peut faire avec ce code QR à faible
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niveau de redondance. Cependant, si
un haut niveau de redondance a été
spécifié à la création du code, de larges
plages de points peuvent être recou-
vertes par une autre information gra-
phique. Bien que cela génère quel-
ques erreurs de lecture, les codes de
correction d'erreur utilisés permettent
encore au lecteur de former le mes-
sage original. Il y a quelques zones du
code qui ne doivent pas être tou-
chées. Comme décrit dans la section
précédente, les marques de position-
nement, d'alignement et de « timing »
sont nécessaires pour un bon fonc-
tionnement. Modifier l'information de

version n'est sans doute pas non plus
une bonne idée. Mais si nous tou-
chons à la partie centrale du code, nous
pouvons prendre quelques libertés

sans trop pénétrer dans une zone
dangereuse.

Pour plus d'idées sur l'utilisation
d'Inkscape, vous pouvez commencer
parla série d'articles de Mark Crutch
dans le FCM ; essayez le Numéro spé-
cial Inkscape Volume 1 (http://www.full-
circlemag.fr/?download/302), en parti-
culier la partie 5 pour des détails sur
le remplissage des zones.

COLOPHON

Je voudrais terminer par deux cas
pratiques qui vont un peu plus loin que
l'utilisation d'un contenu dynamique
dans des affiches publicitaires. Dans
mon travail quotidien de professeur,
je donne souvent aux étudiants des
références où ils pourront trouver plus
d'informations, si nécessaire, sur les
sujets en cours d'étude. Depuis quel-
que temps maintenant, je leur pro-
jette des diapos avec les URL corres-
pondantes. Cependant, même en uti-
lisant les URL raccourcies (« tiny » URL's),
leur copie entraîne trop souvent des
erreurs. En mettant ces URL sous
forme de QR, il est possible pour les
étudiants de venir devant l'écran et
de scanner les codes sur leurs télé-
phones mobiles, ce qui assure la cap-
ture du lien sans erreur humaine. Ils
les ont toujours sur eux ; autant en

profiter pour en faire de bonnes choses
avec ces mobiles, non ?

Une seconde utilisation des codes
QR est le transfert de courtes cita-
tions de textes. Les codes QR sont
capables de contenir plusieurs para-
graphes d'un texte, environ ce qui
peut être utile pour une heure d'étude.
Ainsi, par exemple, le discours clas-
sique de Cicéron contre Catalina pour-
rait être étudié sous forme d'extrait.
Le texte original dit :

«Quousquetandemabutere, Catilina,

patientia nostra?Quam diu etiam furor

iste tuus nos eludet? Quem ad finem

sese effrenata iactabitaudacia?Nihilne

te nocturnum praesidium Palati, nihil

urbis vigiliae, nihil timor populi, nihil

concursus bonorum omnium, nihil hic

munitissimushabendisenatus locus, nihil

horum ora voltusquemoverunt?Patere

tua consilia non sentis, constrictam iam

horum omnium scientia teneri coniura-

tionem tuam non vides?Quid proxima,

quid superiore nocte egeris, ubi fueris,

quos convocaveris, quidconsilii ceperis,

quem nostrum ignorare arbitraris? O

tempora, omores!»

Transformé en diapo pour une
présentation à la classe, puis scanné,
le code QR apparaîtra alors comme
présenté (sur la tablette d'un étudiant) :

Le texte peut ensuite être déversé
dans Google Drive ou une application
de prise de notes, et - on peut l'espé-
rer - être étudié.

En remarque, nous pouvons voir à
travers cet exemple que les codes QR
sont indépendants des systèmes et
qu'ils fournissent une bonne façon de
transmettre des informations entre
systèmes d'exploitation, même si cer-
tains d'entre eux sont plutôt moins
ouverts qu'Ubuntu.

http://fullcirclemagazine.org/inkscape-special-edition-volume-one/
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Écrit par S. J. Webb

Au long des années 60, les Bell Labs
grossirent. Ali Gavan développa

et fit fonctionner le premier laser à
gaz. Les semi-conducteurs et les circuits
intégrés à l'oxyde de métal préparaient
la base de notre société de l'informa-
tion. Bientôt le laser au carbone fut
développé. Unix est né en 1 969. Aaron
March fut le premier concepteur gra-
phique à créer une interface homme-
machine rudimentaire pour les sys-
tèmes informatiques.

Ces changements rapides ont
engendré ceux des années 70. Dennis
Ritchie (ci-dessus) compila le langage

informatique C qu'il utilisa pour ré-
écrire une partie d'Unix. Les câbles à
fibre optique furent développés et
testés à Atlanta, en Géorgie (USA). Le
premier microprocesseur 32-bit fut
déve-loppé. De nombreux autres dis-
positifs téléphoniques furent créés.
Incontestablement, les Bell Labs étaient,
au cours de cette période, la Mecque
du génie technologique.

Cependant, cette période prit fin

en 1 984. Le gouvernement fédéral
des USA morcela ATT du fait de son
monopole considérable dans les ré-
seaux téléphoniques. C'est ainsi que
Western Electric devint le seul pro-
priétaire des Bell Labs. Western Electric
s'appela alors ATT Tech.

Plan 9 (voir ci-dessous) était un
nouvel OS qui devait remplacer Unix
en 1 985. Plus tard, l'OS Inferno fut
développé pour améliorer Plan9. Il y

avait une croissance lente mais conti-
nue dans le développement des nou-
velles technologies. En 1 996, ATT Tech
changea de nom pour Lucent Techno-
logy. Sous ce nouveau nom, le pre-
mier laser organique vit le jour ainsi
que les transistors en plastique. En
2006, Lucent Technology et Alcatel
fusionnèrent sous le nom de Bell Labs.

Cette fusion conduisit à une restruc-
turation. Le centre de recherches com-
mença à s'intéresser uniquement aux
centres de profits. Ainsi, en 2008, un
coup d'accélérateur fut donné au dé-
veloppement des réseaux, de l'élec-
tronique à haute vitesse, des nano-
technologies et des logiciels. Le labo-
ratoire perdit de vu ses objectifs du
fait de la recherche du profit. En 201 3,
le laboratoire se recentra sur ses racines,
les technologies de l'information et
de la communication.

En avril 201 5, Nokia acheta la so-
ciété mère des Bell Labs, et, de ce fait,
Nokia devint propriétaire de ce géant
endormi de la technologie. Nous pou-
vons espérer que Nokia aidera les Bell
Labs à retrouver le chemin de leur
génie.
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JJEEUUXX UUBBUUNNTTUU
Écrit par Oscar Rivera

O ne game to rule them all!
Tolkien's Middle Earth is a vast

insatiable world of fantasy and
adventure. Most people today are
familiar with The Hobbit and the Lord
of the Rings trilogy, but, somewhere
in between, there is a new adventure
that has recently been released as a
video game. Best described as a
single-player, third-person, open-
world, action-adventure RPG, Middle
Earth: Shadow of Mordor takes place
in the time period after Tolkien's The
Hobbit, but before The Lord of the
Rings trilogy.

In September 201 4, Middle Earth:
Shadow of Mordor was first released
for PC, PS4 & Xbox One.
Subsequently, it was also released for
PS3 & Xbox 360 later that year. Most
recently, in July 201 5, Shadow of
Mordor was released for Linux.
Immediately following its Linux
release, word began to spread around
the Linux community that this game
was a must-have. Shadow of Mordor
began to appear in just about every
list of top-ten must-have new
releases with many publications &
websites nominating and/or electing
it as Game of the Year. The list of

accolades includes GDC Game of the
Year, Gamespot's Game of the Year,
and gamesradar Game of the Year –
to name just a few. Gaming on Linux
claimed that it was a “rare (Linux)...
high-quality open-world game... which
had delivered something special.”

After reading so many rave
reviews, I couldn't help but buy it so I

could decide for myself whether this
game was worth everything critics
claimed it was. I was not the least bit
disappointed. Developed by Monolith
Productions, published by Warner
Brothers Interactive Entertainment,
and ported to Linux by Feral
Interactive, Middle Earth: Shadow of
Mordor gets my vote for Linux Game
of the Year. It was rather difficult for

me to put the game down in order to
write this review; that's how good the
game is.

To play the game, you can
download it from Steam or Humble
Bundle for the current regular price
of $49.99 unless you happen to catch
a sale anytime in the near future
which is not out of the question. Once
installed, you're ready to play.
Shadow of Mordor has been
described as a cross between the
Assassin's Creed and the Arkham
Batman series of games. Having
previously played games from both of
those series, I can testify that such
claims are accurate. Anyone who has
played any of the Assassin's Creed or
Arkham Batman games will feel right
at home playing Shadow of Mordor.
However, Middle Earth: Shadow of
Mordor goes above & beyond
anything else ever developed as it has
been injected & infused with enough
creativity & innovation to stand on its
own as a uniquely phenomenal game
that no gamer should do without.

As the game begins, Talion (the
main character), witnesses his family
being murdered by cold-blooded Orc

SShhaaddooww OOff MMoorrddoorr
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warriors fighting for the Black Hand
of Sauron. As the opening sequence
plays out, Talion himself is murdered
by these savage Orcs but his soul is
unable to join his family in the
afterlife. As he is savagely murdered,
Talion somehow merges with an Elf
Wraith who is also out for revenge
against the Black Hand of Sauron.
Having been magically united, Talion
and the Wraith embark on a dark
journey that will take them through
Mordor as they kill Orcs, Uruks, chiefs,
captains and all sorts of beasts,
animals & monsters on their quest to
exterminate the Black Hand of
Sauron and anyone who gets in their
way. Along the way, Talion also co-
operates with other characters such
as Ratbag, the Uruk who Talion helps
become war-chief, and we even work
alongside Gollum who is dying to
obtain his “precious ring.”

Talion can engage in melee,
ranged & stealth combat at the
outset of the game. As the story
unfolds, Talion acquires other combat
skills that enhance his three primary
fighting styles via the use of runes
and learned abilities. When you kill
enemies, especially chiefs & captains,
Talion earns points and runes, but it is
up to you to decide which abilities will
be mastered – which is what gives the
game its RPG element. There are two

sides to Talion, the regular human
side and the wraith-like side – which
are both upgradeable depending on
your playing style. You control Talion
either through mouse/keyboard or a
game controller, both of which work
very well on this game; the choice is
yours. What really sets this game
apart from anything that has ever
gone before, is what's been referred
to as the Nemesis system. Basically,
when an opposing enemy kills you in
this game, not only do you die and
have to re-spawn at a predetermined
forge tower, but the character who
killed you, and any other allies who

might have been with him when you
died, will level up (ie, increase their
level number) and use your death to
their advantage. The way in which the
developers incorporated this concept
into the game is truly fascinating. The
Nemesis system is dynamically
creating a living Mordor which
breathes and pulsates according to
your actions – thus presenting you a
soon-to-be wasteland tailor made for
you.... by you.

For example, there was a captain
in the first half of the game who I
couldn't defeat – no matter how hard

I tried. When I first encountered him,
he was a level 1 3 at a time when I was
just getting comfortable at fighting
against level 8 enemies. With each
death I suffered against him, not only
would he level up, but also his
strengths would increase while his
weaknesses decreased. Eventually, he
was so powerful (lvl 1 8) that I opted
to avoid him at all cost until I felt I was
powerful enough to bring him to his
knees. When I finally chopped off his
head, he had risen to level 20 and just
before my sword sliced through his
neck he even said something like “at
long last you've defeated me.” I
couldn't help but laugh at his
comment and marvel with a dropped
jaw at how this particular captain who
I had helped turn into an unbeatable
foe, even remembered my playing
style and how many times he'd killed
me, among other things. If I call the
Nemesis system genius, I'm still short
of giving it the credit it deserves. I
wouldn't doubt to find influences of
the Nemesis system in future games
still to come.

On my system, Shadow of Mordor
had very few glitches, if any at all. A
couple of times I had to re-start the
game with lower default settings, but
I'll be the first to admit that these
were not so much bugs, but rather
me trying to push my system beyond
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its limits. The game isn't to blame.
The graphics on the game are not
next generation but the fluidity with
which the visuals move in & out of
battle, especially during combat-
finishing moves, are very pleasing to
the eye. The voice acting is another in
a long list of strengths. Shadow of
Mordor also comes with a benchmark
which you can run to test your
system. If you are interested in taking
screenshots of the game, there's
even a feature that can be
enabled/disabled which can
potentially turn you into a real
visionary screenshot publishing artist.

If enabled, the game can be
paused at will and a wide array of
tools appear before you to alter the
paused screenshot and turn it into a
visual masterpiece. You can
completely change the angle, add a
border, focus in/out of it, get up close
or far back, change the “canvas” as it
were, make it black & white, sepia,
etc. It's a feature I found quite useful.

Rather than continue talking
about all of the things I've enjoyed
about this game, it's best I say that
I've seriously been thinking about any
negative aspects of the game and
cannot come up with anything I
dislike about it. Although I'm not
affected by it, I must unfortunately

report that Intel & AMD graphics are
not yet supported, but I understand
that the game should still work fairly
well on very low settings. It would be
a shame if support for AMD & Intel
didn't come soon. I had to contact
Feral Interactive regarding
compatibility problems I had while
playing this game with Valve's new
Steam Controller, and they promptly
replied and gave me some valuable
advice.

Feral Interactive has done a
superb job in bringing this title to
Linux and I cannot think of a better
way to thank them other than buying
Shadow of Mordor. I give the game a
solid rating and strongly recommend
it to everyone.... or rather to all

Mature Audiences who are age 1 8+
since that's the game's well deserved
rating as it is rather graphically
violent.

M INIMUM REQUIREMENTS:

OS: Ubuntu 1 4.04.2 64-bit / SteamOS
Processor: Intel Core i5-750, 2.67 GHz
| AMD Phenom II X4 965, 3.4 GHz
Memory: 4 GB RAM
Graphics: 1 GB NVIDIA 640 or better
with driver version 352.21 or later
Network: Broadband Internet
connection
Hard Drive: 47 GB available space
Additional Notes: AMD and Intel
cards are NOT supported.

http://www.gplus.to/7bluehand
mailto:7bluehand@gmail.com
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MMÉÉCCÈÈNNEESS
MÉCÈNES

Bill Berninghausen
JackMcMahon
Linda P
Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell
Oscar Rivera
Alex Crabtree
John Malon
Ray Spain
Richard Underwood
Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz
Joe Gulizia
Kevin Raulins
Doug Bruce
Pekka Niemi
Rob Fitzgerald
Brian M Murray
RoyMilner
Brian Bogdan
Scott Mack
Dennis Mack
John Helmers

DONS
John Niendorf
Daniel Witzel
Douglas Brown
Donald Altman
Patrick Scango
TonyWood
Paul Miller
Colin McCubbin
Randy Brinson
John Fromm
Graham Driver
Chris Burmajster
Steven McKee
Manuel Rey Garcia
Alejandro Carmona Ligeon
siniša vidović
Glenn Heaton

CHACHACHACHANGEMENT

Notre administrateur est parti, pour de
nombreux mois, sans rien dire à personne
et je ne savais pas du tout, ni si, ni quand,
les frais du site seraient ou ne seraient pas
payés. Au départ, nous devions déménager
le nom de domaine et le site, qui aurait été
hébergé chez moi, et, finalement, j'ai réussi
à retrouver l'admin et à me faire trans-
férer le nom de domaine ainsi que l'héber-
gement du site.

Le nouveau site fonctionne dès à présent.
D'ÉNORMES remerciements à Lucas Wester-
mann (Monsieur Command & Conquer)
d'avoir bien voulu prendre du temps sur
ses loisirs pour recréer complètement le
site, ainsi que les scripts, à partir de zéro.
J'ai fait la page Patreon pour pouvoir rece-
voir de l'aide financière pour ce qui concerne
le domaine et les frais d'hébergement.

L'objectif annuel a été atteint rapidement
grâce à ceux dont les noms figurent sur
cette page. Pas d'inquiétude à avoir : le
FCM ne va pas disparaître.

Plusieurs personnes ont demandé une op-
tion PayPal (pour un don ponctuel) et j'ai
donc rajouté un bouton sur le côté du site.
Merci infiniment à tous ceux qui ont uti-
lisé Patreon et le bouton PayPal. Cela m'a
beaucoup aidé.

https://www.patreon.com/
fullcirclemagazine

https://www.patreon.com/fullcirclemagazine
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CCOOMMMMEENNTT CCOONNTTRRIIBBUUEERR
Équipe Full Circle

Rédacteur en chef - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org
Correction et Relecture
Mike Kennedy, Gord Campbell,
Robert Orsino, Josh Hertel, Bert Jerred,
Jim Dyer et Emily Gonyer

Remerciements à Canonical, aux nombreuses
équipes de traduction dans le monde entier
et à Thorsten Wilms pour le logo du FCM.

Pour la traduction française :
http://fullcirclemag.fr.

Pour nous envoyer vos articles en français
pour l'édition française :
webmaster@fullcirclemag.fr

FULL CIRCLE A BESOIN DE VOUS !
Un magazine n'en est pas un sans articles et Full Circle n'échappe pas à cette
règle. Nous avons besoin de vos opinions, de vos bureaux et de vos histoires.
Nous avons aussi besoin de critiques (jeux, applications et matériels) , de
tutoriels (sur K/X/Ubuntu), de tout ce que vous pourriez vouloir communiquer
aux autres utilisateurs de *buntu. Envoyez vos articles à :

articles@fullcirclemagazine.org

Nous sommes constamment à la recherche de nouveaux articles pour le Full Circle. Pour de l'aide
et des conseils, veuillez consulter l'Official Full Circle Style Guide :
http://url.fullcirclemagazine.org/75d471

Envoyez vos remarques ou vos expériences sous Linux à : letters@fullcirclemagazine.org

Les tests de matériels/logiciels doivent être envoyés à : reviews@fullcirclemagazine.org

Envoyez vos questions pour la rubrique Q&R à : questions@fullcirclemagazine.org

et les captures d'écran pour « Mon bureau » à : misc@fullcirclemagazine.org

Si vous avez des questions, visitez notre forum : fullcirclemagazine.org

FCM n° 1 04
Dernier délai :
dimanche 5 décembre 201 5
Date de parution :
vendredi 27 décembre 201 5

Format EPUB - Les éditions récentes du Full Circle comportent un lien vers le fichier epub sur la page de téléchargements. Si vous avez des
problèmes, vous pouvez envoyer un courriel à : mobile@fullcirclemagazine.org

Issuu - Vous avez la possibilité de lire le Full Circle en ligne via Issuu : http://issuu.com/fullcirclemagazine. N'hésitez surtout pas à partager
et à noter le FCM, pour aider à le faire connaître ainsi que Ubuntu Linux.

Google Play - Vous pouvez maintenant lire le Full Circle sur Google Play/Livres. Recherchez « full circle magazine » ou cliquez sur ce lien :
https://play.google.com/store/books/author?id=Ronnie+Tucker

Obtenir le Full Circle en français : http://www.fullcirclemag.fr/?pages/Numéros.

Obtenir le Full Circle en anglais :

mailto:ronnie@fullcirclemagazine.org
mailto:admin@fullcirclemagazine.org
mailto:articles@fullcirclemagazine.org
mailto:podcast@fullcirclemagazine.org
http://url.fullcirclemagazine.org/75d471
http://ubuntuforums.org/forumdisplay.php?f=270
mailto:letters@fullcirclemagazine.org
mailto:reviews@fullcirclemagazine.org
mailto:questions@fullcirclemagazine.org
mailto:misc@fullcirclemagazine.org
mailto:mobile@fullcirclemagazine.org
https://apps.ubuntu.com/cat/
http://issuu.com/fullcirclemagazine
http://fullcirclemag.fr
mailto:webmaster@fullcirclemag.fr
mailto:mobile@fullcirclemagazine.org
http://issuu.com/fullcirclemagazine
http://www.fullcirclemag.fr/?pages/Num�ros
https://play.google.com/store/books/author?id=Ronnie+Tucker

